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Limitations on Use

For Research Use Only (RUO). Not for use in diagnostic procedures.

Hyperlink Disclaimer

Bruker DaltonikGmbH makes no expresswarranty, neither written nor oral, and is neither
responsible nor liable for data or content from the linked Internet resources presented in
this document.
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Contact

Contact your local Bruker Daltonics representative for service and further information.

USA Germany
Bruker Daltonics Inc
40Manning Road
Billerica, MA 01821
USA

Bruker DaltonikGmbH
Fahrenheitstraße 4
28359 Bremen
Germany

Phone: +1 978 6633660 Phone: +49 421 2205-345
Fax: +1 978 6675993 Fax: +49 421 2205-390
Internet: www.bdal.com Internet: www.bdal.de

Service Support

Phone: +1 978 6633660-1445

E-mail: service-support@bdal.com

Service Support

Phone: +49 421 2205-350

E-mail: maldi.sw.support@bdal.de
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1 Introduction

flexControl is a program designed to configure and operate time- of- flight mass
spectrometers of the Bruker flex series, such as the microflex, autoflex and ultraflex
instruments. flexControl runs under Microsoft® Windows® XP® (SP3) or Windows 7
operating systems. The Bruker post processing software flexAnalysis 3.4 can reload
recorded spectra from the disk for post processing.

Before installing flexControl 3.4 for the first time, Microsoft .NET Framework 2.0 must
have been installed. For more information, refer to the installation instructions that are part
of the Compass installation. 

Figure 1-1 Dialog on the Compass installation CD

flexControl uses standard Microsoft® Windows® conventions to operate with windows,
menus, dialog boxes, and the mouse.  The operator should be familiar with the basic
operation of the computer and with Microsoft® Windows ® software.  Some general
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instructions are given here, but if additional support is necessary regarding the basic use of
a computer, please review its accompanying documentation.

Depending on themass spectrometer (autoflex, microflex, ultraflex TOF/TOF), flexControl
offers features specific to the respective unit.

flexControl 3.4 (Compass 1.4 for flexSeries) is able to operate in combination with the
Bruker Compass Security Pack. The Bruker Compass Security Pack and user
management are described in a separatemanual.

Main features of the Bruker Compass Security Pack are electronic signatures, audit
trailing, and user management. Note that this is different to the user management of the
operating system.

Bruker User Management is a tool that allows managing access to Bruker applications
and assigning individual privileges to users. Operator IDs and passwords identify such
privileges. The access of a user to features of Bruker applications depends on these
privileges. 

On saving data files, the operator can electronically sign them, if they have this specific
privilege. Electronic signatures are created using the operator's ID and their password. 

Audit trails are useful for tracing the operations performed at a specific time point. 
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2 Getting Started

2.1 Installation

Please refer to the separate installation instructions on the installation DVD, or contact
Bruker via e-mail (maldi.sw.support@bdal.de) to install flexControl 3.4 on the instrument
control computer.

2.2 Starting flexControl

In accordance withWindows conventions, flexControl can be started via theWindows
Start menu.  During installation of the Bruker Daltonics Applications package, a Bruker
Daltonics folder was automatically created in the Start menu's Programs folder, which
contains the respective applications. 

A second way to launch flexControl is by double clicking the corresponding icon  on
theWindows desktop.

During start up of the program (see Figure 3-1) the last loaded method automatically
opens. If a dialog informing the user that the method has been saved with another
flexControl version appears, click OK  to save the method. flexControl can acquire five
different types of spectra and therefore offers five different method types; each identified
by a specific file extension:

l <file name>.par (for standard applications).

l <file name>.lft (for LIFT applications on a tandemmass spectrometer).

l <file name>.psm (for FAST applications).

l <file name>.isd (for applicationswith undigested proteins).

l <file name>.srm (for single reactionmonitoring applications).

If a LIFTmethod is loaded, the LIFT page (see section 3.7.9) appears additionally and the
Calibration page (see section 3.7.8) changes. If a FASTmethod is loaded, the FAST
page is shown (see section 3.7.10). If a LIFT method is loaded on a non-LIFT instrument
the followingmessage appears:
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Figure 2-1 flexControl has not detected a tandem instrument

2.3 Closing flexControl

To close flexControl, click the application's Close button , select File > Exit, or press
ALT + F4. 

If the currently loaded method or instrument setting file (*.isset) have been changed
but not saved, message dialogs appear asking the user to save the respective settings.

SelectNo orCancel to stay in flexControl and save the files under different file names.
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3 Graphical User Interface (GUI)

Figure 3-1 Graphical user interface of flexControl

The flexControl GUI shows the current entire status of the system.  It is used to configure
and control a mass spectrometer of the flex-series in order to acquire data.

TheGUI (see Figure 3-1) is composed of the following items:

l Title bar (see section 3.1)

l Menu bar (see section 3.4)

l Toolbar (see section 3.2)

l Status bar (see section 3.4.3.2)

l Video optics and acquisition control (see section 3.5.1)
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l MTP sample carrier control (see section 3.5.2)

l Online display (see section 3.6)

l System configuration segment (see section 3.7).

3.1 Title Bar

The title bar (see Figure 3-2) reflects the type of the mass spectrometer, for example,
ultraflex and the currently loaded method. The left edge of the title bar contains the
application's control menu button and the right edge contains the familiar Windows
minimize, maximize, and close buttons.

Figure 3-2 Title bar in flexControl

3.2 Toolbar

Figure 3-3 Toolbar of flexControl

Commonly used menu commands can be accessed through toolbar buttons. These
buttons are organized into five groups. 

l Filemenu commands (see section 3.4.1).

l Displaymenu commands (see section 3.4.2).

l Viewmenu commands (see section 3.4.3).

l Toolsmenu commands (see section 3.4.4).

l Helpmenu commands (see section 3.4.5).

The buttons available in the toolbar can be configured by the user (see section 3.4.3.1).

Page 14 of 166 flexControl 3.4 User Manual Revision 1



Bruker Daltonik GmbH 3 Graphical User Interface (GUI)

3.3 Status Bar

The status bar (see Figure 3-4) is located at the bottom of the GUI. It displays several data
parameters, such as instrument mode, current user, coordinates of the mouse pointer,
status of the instrument and target location.

Figure 3-4 Status bar of flexControl

3.4 Menu Bar

The menu bar (see Figure 3-5) consists of six drop-down menus. Each menu contains
groups of commands related to this menu. Many menu commands can also be accessed
using toolbar buttons (see section 3.2) or short cuts.

Figure 3-5 flexControl menu bar

3.4.1 File Menu

Figure 3-6 File menu commands
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The File menu (see Figure 3-6) contains commands for handling methods, saving data,
and printing reports.

Table 3-1 Feature buttons of the File menu with corresponding tasks

Toolbar
button

Menu
command Shortcut Description

Save Spectrum
to File

CTRL+S Saves spectrum.

Save Spectrum
to File As

Saves spectrum under another
name.

Select Method Opens a dialog box to select a
method from the file system.

Save Method CTRL+M Saves themethod.

Save Method
As

Opens a dialog to save a
method with a new name.

Print CTRL+P Prints a report of the selected
analyses.

Print Preview Displays print preview using the
selected report layout.

Print Setup Displays the Windows dialog
for printer setup.

Exit ALT+F4 Closes flexControl.

3.4.1.1 Save Spectrum to File

The current spectrum can be saved to disk by:

l selecting File > Save Spectrum to File,

l clicking the corresponding button in the toolbar or the Acquisition Control
section ,

l or using the short cut (CTRL+S).
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flexControl supports two spectrum data formats:

l the XMass format (see Figure 3-7) in which each spectrum is saved in a separate
folder/file structure. This is the traditional format for spectra from flex series
instruments.

l the new container format introduced with Compass 1.4.

flexControl handles names of saved spectra in such amanner that overwriting of spectra is
automatically avoided. Every Save process performed in a directory generates a
numerated subfolder with a new analysis tree.

Figure 3-7 Example of the XMass file structure

Raw data are stored in a fid file. Processed data are stored in a 1r file. Each analysis
contains both files. If raw data are not yet processed both the fid and the 1r files contain
the same data.

In the container data format (see Figure 3-8), all data from an autoXecute run with the
same sample name are saved in a single directory with a .d extension that contains only a
few files. Bruker software never prompts for files within the directory, it only requests the
.d directory.

The container format is only used for automaticmeasurements for LC-MALDI andMALDI
imaging.

When saving a file for the first time, the file structure must be generated, and a dialog
appears (see Figure 3-9). If the Save command has already been used in a flexControl
session for this spectrum type, the file is automatically saved, since a valid path- and
sample name exist.
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Figure 3-8 Example of the container data format

Figure 3-9 Save (As) dialog to specify data directory and possible post-processing
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l Single/Sum: Select the desired option to save the single or the sum buffer.

l Comments : Comments are saved with the spectrum and appear in post-
processing tools like flexAnalysis and BioTools.

l Process with: Specifies amethod for post processing in flexAnalysis if it is installed
on the same computer. When opening a spectrum the first time in flexAnalysis the
assigned processingmethod will be executed.

l Open in flexAnalysis: If this check box is selected, the spectrum is automatically
sent to flexAnalysis and any assignedmethod is executed. If nomethod is assigned,
the spectrum opens in flexAnalysis with a defined default method (see flexAnalysis
User Manual).

l Run: This feature should be used to save the information on a measured MS spot
(path, sample name and comments) and use it for MS/MS measurement on this
spot afterwards.

o Select the Add to Run check box to store the MS information in the currently
displayed AutoXecute Run. If no run is loaded, a new one, named yyyymmdd_
hhmmss.xml, is automatically created in the folder
D:\Methods\AutoXSequences\ManualMeasurements.

o It is possible to transfer (different) comments and sample names for different
spots in one run. During the subsequent LIFT measurement, the spot
information is automatically loaded into the Save (As) dialog, enabling LIFT
spectra to be saved alongside the correspondingMS spectrum.

►► To use this feature

1. In theAutoXecute tab, select none forAutoXecute run.

2. Acquire aMS spectrum, open theSave As dialog and select the check boxAdd to
Run.

3. Change the settings (path, sample name,…) if necessary and save the spectrum.

4. Load a LIFT method and start the manual LIFT acquisition for any LIFT mass on the
green spot where theMS spectrum has been acquired.

5. Open theSave As dialog where the correct spot information has been transferred and
the LIFT spectrum can be saved directly.
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This feature can also be used to perform manual MSmeasurement and/or select masses
for LIFTmanually and automatically perform subsequent LIFTmeasurements.

For details please refer to the Quickstart_PrecursorSelection.pdf available on
the installation DVD.

l Add to Run: If a run is loaded and this check box is activated, the data directory,
sample name information, comments and any selected flexAnalysis method are
transferred from the run to theSave As dialog.

l Path: Select a data directory for the results. Use the button to change
the path.

l Sample: Type a sample name.

l Sign Spectrum: If the Compass Security Pack is installed, spectra can be signed
during the save process (if the user has the specific privilege). A valid operator and
password are required.

Note If a spectrum is signed in flexControl, it is write- protected. No post
processing results can be stored with flexAnalysis or any other programs.

Figure 3-10 Signing a spectrum
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3.4.1.2 Save Spectrum to File As

The current spectrum can be saved to disk under another name by:

l selecting File > Save Spectrum to File As,

l clicking the corresponding button in the toolbar or the Video Optics and

Acquisition Control section ,

The dialog that appears every time Save Spectrum to File As is selected is the same as
for theSave Spectrum command.

This command is unavailable in case of a FAST measurement, as saving is automatically
done after switching to the next segment. Even at the end of a manual FAST
measurement, the spectrum is automatically saved to the path and sample name selected
on the FAST page (see section 3.7.10).

3.4.1.3 Select Method

The Select Method command and the corresponding icon on the toolbar open a
dialog for selecting one of the following flexControl methods:

l *.par for fingerprint spectra.

l *.psm for FASTmeasurements.

l *.lft for LIFT measurements on a tandemmass spectrometer.

l *.isd (Ion Source Decay) for measurements of fragments arising inside the ion
source.

l *.srm (Single ReactionMonitoring) for measurements with only one fragment.
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Figure 3-11 Open flexControl Method dialog

3.4.1.4 Save Method

TheSave Method command saves the currently loaded (write-enabled) method.

3.4.1.5 Save Method As

The Save Method As command, and the corresponding icon of the toolbar open a
dialog for saving the currently loadedmethod with a new name.

3.4.1.6 Print

A printer can be selected by:

l selecting File > Print

l clicking the corresponding icon of the toolbar

l or using the short cut (CTRL+P)

Click to start printing.
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Figure 3-12 Print dialog

3.4.1.7 Print Preview

The Print Preview command is used to check the appearance of a spectrum before
printing (see Figure 3-13). ClickPrint to start printing from this dialog.

Figure 3-13 Print Preview dialog
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3.4.1.8 Print Setup

The Print Setup command is used to adjust the default printer settings and opens the
following dialog.

Figure 3-14 Print Setup dialog

3.4.1.9 Exit

TheExit command and the short cut ALT+F4 are used to close flexControl. Before closing
a confirmation dialog appears (see Figure 3-15). ClickYes to close flexControl.

Figure 3-15 Close flexControl by applying “Yes”

If the currently loaded method or instrument setting file (*.isset) have been changed
but not saved, message dialogs appear asking the user to save the respective method
(see Figure 3-16) or instrument (see Figure 3-17) settings.

SelectCancel to stay in flexControl and save the files under different file names.

Page 24 of 166 flexControl 3.4 User Manual Revision 1



Bruker Daltonik GmbH 3 Graphical User Interface (GUI)

Figure 3-16 Save changed methods confirmation dialog

Figure 3-17 Save modified instrument settings confirmation dialog

3.4.2 Display Menu

Figure 3-18 Display menu commands

TheDisplaymenu (see Figure 3-18) contains commands for manipulating spectra. 
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Table 3-2 Features of the Display menu

Toolbar
button Menu command Description

Zoom Zooms the selected data range.

Undo Last
Zooming

Undoes the last zooming step.

Maximum Cursor
Left

Clicking to the left of a peak sets an arrow label at the
top of the peak.

Data Cursor Sets an arrow label at the spectrum y-postion directly
below themouse pointer.

Free Cursor

Label Peaks

Show peak
information

Smooth Spectrum
(Acquisition
Buffer)

Smooths the spectrum in the active acquisition buffer.

Smooth Spectrum
(Sum Buffer)

Smooths the spectrum in the active sum buffer.

Subtract Baseline
(Acquisition
Buffer)

Subtracts the baseline of the spectrum in the active
acquisition buffer.

Subtract Baseline
(Sum Buffer)

Subtracts the baseline of the spectrum in the active
sum buffer.

Undo Processing
(Acquisition
Buffer)

Undoes smoothing and/or baseline subtraction of the
acquisition buffer

Undo Processing
(Sum Buffer)

Undoes smoothing and/or baseline subtraction of the
sum buffer
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Toolbar
button Menu command Description

Abscissa Units
Mass

Mainly used for standard operation.  m/z scale
represents a calibratedmass spectrum.

Abscissa Units
Times

Mainly used for debugging purposes.  t [ns] denotes a
raw time-of-flight-spectrum displayed in
nanoseconds.

Abscissa Units
Points

Mainly used for debugging purposes.  Shows how
many data points are distributed over the peak shape.

Linear Detector
Single Spectrum

Displays a single shot, usually the last acquired
sequence of shots.

Sum Spectrum Displays at least a single shot, usually the last
acquired sequence of shots.

One Display One display is shown.

Two Displays Two displays, split vertically.

Two Displays Two displays, split horizontally.

Three Displays Three displays, split horizontally.

Three Displays Three displays, split vertically.

3.4.2.1 Zoom

The Zoom command and the corresponding icon of the toolbar are used to enlarge a
section within the Mass Spectrum window. The zoom function is active after the
corresponding tool button is applied. Then the mouse pointer converts into the zoom

pointer (within theMass Spectrumwindow). 

To enlarge a mass range, move the zoom pointer to the initial position and press the left
mouse button. Hold the button, move to the final position (in x and y direction), and release
themouse button. This action draws a rectangle inside the Mass Spectrum window.  The
content will be shown enlarged. 
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3.4.2.2 Undo Last Zooming

The Undo Last Zooming command and the corresponding icon of the toolbar are
used to reverse the last zooming step that was performed in the Mass Spectrum window
via the Zoom command. 

3.4.2.3 Maximum Cursor Left

TheMaximum Cursor Left command and the corresponding icon of the toolbar are
used to create an additional cursor, which is always located left- hand to the mouse
pointer.  Left click of themouse button fixes the cursor to that y-position (top of a peak) next
to themouse pointer, which is just higher.

3.4.2.4 Data Cursor

The Data Cursor command and the corresponding icon of the toolbar are used to
create an additional cursor that follows always the mouse pointer on the left side sliding
over the peaks.

3.4.2.5 Free Cursor

The Free Cursor command and the corresponding icon of the toolbar are used to
create an additional cursor that accompanies the mouse pointer with an F.  This mark
might be fixed as desired by using the left mouse button.

3.4.2.6 Label Peaks

The Label Peaks command and the corresponding icon of the toolbar are used to
perform peak picking in the active buffer.  The peak picking parameters can be set using
theProcessing Parameter dialog (see Figure 3-86).

3.4.2.7 Show Peak Information

TheShow Peak Information command, or the corresponding icon of the toolbar are
used to open a window (see Figure 3-19), which contains the four (five) most important
peak characteristics. This command is only available together with the activated

Maximum Cursor Left button .
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Figure 3-19 Example of peak characteristics

3.4.2.8 Smooth Spectrum (Acquisition/Sum Buffer)

The Smooth Spectrum (Acquisition/Sum Buffer) command and the corresponding

icons / of the toolbar are used to smooth the spectrum in the respective buffer. The
algorithm used for this can be adjusted via the Processing Parameter method (see section
3.7.5).

3.4.2.9 Subtract Baseline (Acquisition/Sum Buffer)

TheSubtract Baseline (Acquisition/Sum Buffer) command, or the corresponding icon

/ of the toolbar are used to subtract the baseline of the spectrum in the respective
buffer. The algorithm used for this can be adjusted via the Processing Parameter method
(see section 3.7.5).

3.4.2.10 Undo Processing (Acquisition/Sum Buffer)

Undoes smoothing and/or baseline subtraction of the acquisition/sum buffer.

3.4.2.11 Abscissa Units

flexControl allows choosing between three scaling factors for the x-axis. TheAbscissa
Units commands and the respective icons of the toolbar are used to assign one of these to
the abscissa. 

flexControl 3.4 User Manual Revision 1 Page 29 of 166



3 Graphical User Interface (GUI) Bruker Daltonik GmbH

Mass

:
Mainly used for standard operations. m/z scale is default.

Time

:
Mainly used for debugging purposes.  t [ns] denotes a raw time-of flight-
spectrum displayed in nanoseconds.

Points

:
Mainly used for debugging purposes.  Shows how many data points are
distributed over the peak shape.

3.4.2.12 Buffers

On the TOF-instruments of the flex series are two buffers available. One is used to store a
single spectrum, the other one is used to add spectra.

l The Single Spectrum buffer displays at least a single shot, usually the last
acquired sequence of shots.

l The Sum Spectrum buffer displays the total number of added spectra.  The
button reverses the last operation.

flexControl allows for scaling the single buffers with regard to the respective sum buffer. 
The available three scaling modes have no influence on the buffer contents.  They are
exclusively used for displaying spectra in the RTD (Real Time Display) (Mass Spectrum
window). 

flexControl performs only scaling when data are already stored on the sum buffer and the
corresponding sum buffer is chosen. Toggling between the scale modes takes only effect,
when an acquisition is running. Changing the mode before or after an acquisition has no
influence on the display. 

Below the RTD (see Figure 3-20) is an arrangement of three radio buttons to choose a
suitable scalingmode. 

l None: No scaling of the single buffer is performed. 

l 90%: The scaling of a single buffer is performed in amanner that itsmost intensive
peak has 90% of the height of the most intensive peak of the sum buffer.  This
feature enables comparison of peaks in the single buffer and in the respective sum
buffer on the basis of position, shape and size. 
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l Shot ratio: Using thismode, scaling of the single buffer is performed with regard
to the total number of shots. After the shot sequence is finished the peak size of the
single buffer corresponds to that of the sum buffer. In this mode the user can
observe the increase of the peak intensity. Thus he can verify immediately the
current peak intensity and its deviation from the average. 

3.4.2.13 Split

Figure 3-20 Mass Spectrum window displayed in one of the split modes

TheSplit command, or one of the corresponding icons on the toolbar are used to display
more than one spectrum at a time (see Figure 3-20), in order to facilitate manipulations,
e.g., to compare segments of a spectrum.
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3.4.3 View Menu

Figure 3-21 Contents of the View menu

TheViewmenu (see Figure 3-21) is composed of commands to configure the GUI. 

Table 3-3 Features of the View menu

Menu command Description

Toolbars Opens the dialog toolbars.

Status Bar Show or hides the status bar.

3.4.3.1 Toolbars

The Toolbars command opens the Toolbars dialog box (see Figure 3-22) to customize
the toolbar of the GUI. Select or clear the check box next to a toolbar to show or hide it in
the flexControl GUI. The change is immediately shown in flexControl.

ClickNew to create a toolbar with a user-defined selection of buttons. TheCustomize
dialog (see Figure 3-29) opens. Select the Commands tab to choose available buttons.
Drag and drop the desired buttons into the toolbar.

Figure 3-22 Toolbars dialog box
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3.4.3.2 Status Bar

TheStatus Bar command is used to show or hide the status bar (see Figure 3-23), which
is located at the bottom of the GUI. If the status bar is visible, this is indicated by a
highlighted checkmark left hand to the command.

The status bar contains the type of currently loadedmethod, the name of the current user,
the coordinates of themouse pointer and the status Information of the instrument.

Figure 3-23 Example of a status bar

3.4.4 Tools Menu

Figure 3-24 Contents of the Tools menu

The Tools menu (see Figure 3-24) is composed of various commands for different
features, e.g., to re-align the video camera, choose a post processing application, etc.
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Table 3-4 Feature buttons of the Tools menu with related functions

Feature
button ToolTip text Menu

command Shortcut Description

Load last saved
spectrum into post-
processing application

Load Last
Spectrum into
flexAnalysis

Transfers the last saved
spectrum directly into
flexAnalysis.

Copy Video
Snapshot to
Clipboard

Takes a snapshot of the
video display and copies
it to the clipboard

Camera Show Camera
Picture

Toggles spot symbol and
true video

Pause Camera
Picture

F3 Corresponds to pause on
a video recorder.

Camera teaching Teach Camera
Control
Features

Opens a dialog for
camera adjustments.

Repeat shot cycle Repeat shot
cycle

Repeats the last shot
sequence until
termination.

Method Cal-
ibration Param-
eters

Parameterizes param-
eters for the automatic
MS calibration

Preferences Opens thePreferences
dialog

Customize Customizes the toolbar.

3.4.4.1 Load Last Spectrum Into flexAnalysis

The Load Last Spectrum Into flexAnalysis command and the corresponding icon
of the toolbar are used to transfer the last saved spectrum directly into this post-processing
software. 
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3.4.4.2 Copy Video Snapshot to Clipboard

The Copy Video Snapshot to Clipboard command takes a snapshot of the current
image in the video display and copies it to the clipboard.

3.4.4.3 Show Camera Picture

The Show Camera Picture command and the corresponding icon on the toolbar
allow switching the camera video off and on. 

3.4.4.4 Pause Camera Picture

ThePause Camera Picture command and the short cut (F3) are used to pause the video
signal. In flexControl this is shown below the video (see Figure 3-25) . During Webex
sessions, pausing the video signal is recommended for faster data transfer.

Figure 3-25 Paused video picture

3.4.4.5 Teach Camera Control Feature

The Show Teach Camera Control Feature command and the corresponding icon
on the toolbar are used to open a dialog for matching target size and position with the
camera position (see Figure 3-26). 
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Figure 3-26 Parameters to match target size and camera position

The feature Teach Video Control (see Figure 3-26) is an alignment tool in order to match
the screen coordinates and respectivemotor positions

Note The settings have been adjusted in the factory – they must not be changed by
the user!

3.4.4.6 Repeat Shot Cycle

TheRepeat Shot Cycle command, or the corresponding icon of the toolbar are used
to repeat the last shot sequence until the command or the button are applied a second
time. 

3.4.4.7 Method Calibration Parameters

Thismenu item opens the Edit Auto Calibration Parameters dialog (see Figure 3-27).
It is used to adjust the parameters used for automatic re-calibration of the MS acquisition
method (see section 3.7.7).
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Figure 3-27 Edit Auto Calibration Parameters dialog (example settings)

The individual settings have the following effect:

AutoXecute Method

This selection specifies the AutoXecutemethod that is used for data acquisition during the
automaticMS re-calibration.

Smooth Spectrum before calibration

If the entry is selected, the acquired spectrum is smoothed using the algorithm specified in
the processing parameters before performing the peak finding and assignment algorithms.
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Min. Number of assigned Peaks

Specifies theminimum number of peaks that bematched against themass control list. If 0
is used, theminimumnumber of peaks depends on the calibrationmode.

Max. Std. Deviation (ppm)

If the standard deviation of the new calculated calibration exceeds the value specified
here, the new calibration is rejected.

Max. Peak Error (ppm)

If the error of an individual assigned peak exceeds the value specified here, the new
calibration is rejected.

Mass Range Coverage (%)

This value specifies the minimum coverage for the assigned peaks in relation to the mass
range. Example: The mass range of the acquisition method goes from 500 to 3500 Da. A
coverage 60% then means that the first and last assigned peaks must have a minimum
distance of 1800 Da (60% of 3000 Da).

Override Peak Finder Min. Intensity Threshold

If this element is selected, the value entered is used for the peak finder minimum intensity
setting instead of the parameter specified in the processing parameters dialog.

Override Smoothing Width

If this element is selected, the value entered is used for the smoothing width setting instead
of the parameter specified in the processing parameters dialog.

Save flexControl Method after successful calibration

If the entry is selected, the acquisition method is automatically saved after successfully
completing the automaticMS re-calibration.
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Display Message after successful calibration

If the entry is selected, a message will be displayed after successfully completing the
automaticMS re-calibration.

The method calibration parameters are stored in the flexControl method so that different
parameters can be used for automatic re-calibration e.g. on peptides and proteins.

3.4.4.8 Preferences

ThePreferences command opens thePreferences dialog (see Figure 3-28). This dialog
is used to alter the settings used for checking for updates.

Figure 3-28 Preferences dialog

When flexControl is launched from the start menu or desktop icon, it checks if updates are
available if the interval since the last check has expired. If an update is found, it informs the
user.

The software contacts a Bruker server for the check. Refer to the release notes on
implications such as firewall configuration.
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Last Check

This field lists the data of the last update check.

Update interval

This element specifies the interval between automatic checks. Possible choices are
Never,Always (on every start),Daily,Weekly andMonthly.

Ignore chargeable updates

If this element is selected, the software only checks for free updates and ignores future
Compass releases.

Check Now

If this button is clicked, the software immediately performs the check for updates and
displays the result.

3.4.4.9 Customize

The Customize command opens the Customize dialog (see Figure 3-29). It is used to
vary the contents of themenu bar. Additionally the user can remove or add parts of the
toolbar.
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Figure 3-29 Customize > Toolbars dialog

3.4.5 Compass Menu

Figure 3-30 Content of the Compass menu
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Table 3-5 Features of the Compass menu

Menu
commands Shortcut Description

License Enter the license number here.

Operator Changes the operator.

Lock all
Applications

CTRL+ALT+K Locks all programs in case the Compass Security
Pack is installed.

Compass
Desktop

F11 Opens the CompassDesktop.

flexAnalysis SHIFT+ALT+F11 Opens flexAnalysis.

BioTools ALT+F12 Opens BioTools.

Genotools OpensGenoTools.

Audit Trail
Viewer

Opens the Audit Train Viewer in case the Compass
Security Pack is installed.

3.4.5.1 License

The License command is used to open the Bruker Daltonics License Viewer dialog
box (see Figure 3-31) for viewing or adding/removing licenses for Bruker products. The
LicenseViewer (andManager) look the same in nearly all programs. It is not necessary to
enter a license for a certain Bruker program in the respective program; it can be entered
via the License Manager of other Bruker programs.
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Figure 3-31 The Bruker Daltonics LicenseViewer

To enter a license click the Edit button. On some computers it might be necessary, even
when the administrator is logged in, to explicitly select the administrator and enter the
respective password. The License Manager will then open:

Figure 3-32 The Bruker Daltonics LicenceManager
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3.4.5.2 Operator

TheOperator command opens the flexControl log on dialog (see Figure 3-33) and is used
to log on as new operator. The new operator name appears in the status bar at the bottom
of the GUI. In case the Bruker Daltonics UserManagement is installed, an additional
password is requested. If a user logs on with the Operator command the user
automatically changes for all other Bruker programs that are currently opened and
runnning with the UserManagement. In flexControl theSelect Method dialog appears.

Figure 3-33 Log On operator dialog

If the Bruker UserManagement is not installed, the conventional Operator log on dialog
appears (see Figure 3-34). 

Figure 3-34 Conventional Log On operator dialog

Page 44 of 166 flexControl 3.4 User Manual Revision 1



Bruker Daltonik GmbH 3 Graphical User Interface (GUI)

3.4.5.3 Lock All Applications

The Lock all Applications command and the short cut (CTRL+ALT+K) lock all
applications that are currently open depending on the lock-time that is defined in the
UserManagement. Additionally the Unlock dialog opens. After a timeout, that is
adjustable via the UserManagement, the software is locked automatically. 

If one program is locked (manually or via timeout), all programs that run with the
UserManagement are locked, since they all use the sameUserManagement server. In this
case it is also necessary to unlock only one program. A locked program can only be
unlocked from the user who locked it, or from the UserManagement administrator.

Figure 3-35 Unlock applications dialog

3.4.5.4 Compass Desktop

TheCompass Desktop command opens the so-called Bruker Compass. ThisGUI offers
access to the installed Bruker programs categorized inAcquisition, Processing,Data
Interpretation, and the correspondingmanuals.
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Figure 3-36 The Compass desktop

3.4.5.5 flexAnalysis

The flexAnalysis command is used to open flexAnalysis or bring it to front if it is already
open. Data transfer is not achieved with this command, i.e. no spectrum is sent to
flexAnalysis. To send a spectrum to flexAnalysis, use the button Load last saved
spectrum into flexAnalysis (see section 3.4.4.1).

3.4.5.6 Audit Trail Viewer

The Audit Trail Viewer command opens the Bruker Daltonics AuditTrailViewer
dialog. It is only available if the Bruker UserManagement is installed.
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Figure 3-37 The Bruker Daltonics AuditTrailViewer

3.4.6 Help Menu

Figure 3-38 Contents of the Help menu

The Help menu (see Figure 3-38) is composed of commands referring to copyright and
license information, and to electronic support.
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3.4.6.1 Help Topics

TheHelp Topics command opens the online-help system and displays the help system’s
contents page. 

3.4.6.2 Service Access

Some interface elements of flexControl are only available for authorized service personnel
and read-only for other users. To gain access to these settings, this command opens the
Service Access dialog (see Figure 3-39).

Figure 3-39 Service Access dialog

3.4.6.3 Report Status

The Report Status command launches the Status Reporter (see Figure 3-40) that is
used to collect helpful information of the instrument and the computer. TheStatus
Reporter also starts in case of an error in flexControl to help the user to collect necessary
information for the support concerning the current system state.
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Figure 3-40 Status Reporter

3.4.6.4 About Bruker Daltonics flexControl

This command opens a window (see Figure 3-41) containing the software version,
copyright information, the usedmass spectrometer, and the support address.
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Figure 3-41 The About Compass flexControl dialog box

3.5 Main Instrument Control

This part of the flexControl GUI comprises features of the video, data acquisition and
method information aswell as the sample carrier.
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3.5.1 Video Optics and Acquisition Control

Figure 3-42 Video optics and acquisition control

The slider on the right of the video picture is used to adjust the laser intensity. This can be
done with mouse clicks or with themouse wheel since the focus is on the laser slider after
a click in the video picture.  

The six buttons located below the video are used for data acquisition and collection.
Additional fields specify the laser settings.

A click with the left mouse button (or ALT+C) will erase the
contents of the linear and reflector sum buffers. 

Undo (or ALT+U) deletes the last added shot sequence from
the sum buffer.

Start (or ALT+S) starts a manual acquisition. During a run it
toggles to a Stop-button, which might be used to terminate the
shot sequence immediately.

Stop (or ALT+T) stops amanual acquisition. 
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Add (or ALT+A) transfers the current contents of the linear or
reflection detector to the corresponding sum buffer. The data
will be added to data previously acquired. This should be done
only with good spectra in order to maximize the quality of the
sum spectrum.

Save (or CTRL+S) saves the current spectrum.

Saves the current spectrumwith a new name.

Information on how many shots are currently acquired and how
many are required.

How many shots have been added to the sum buffer.

Adjusts the laser trigger frequency. Higher frequencies result in
faster data acquisition.

3.5.2 MTP Control and Method Selection

Figure 3-43 Target control features
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Depending on the target that is currently used in the instrument the respective geometry is
presented. If it is a target with chips (see Figure 3-43), the different available chips are

visualized beneath the target ( ) and can be chosen by clicking a circle. The currently
active chip — chip 0 — (see Figure 3-43) is shown in blue. In the following example (see
Figure 3-44) "chip 1"— i.e. the calibration spots— are selected.

The currently active sample spot ismarked with a blue (system color dependent) square in
the plate view. This information is additionally shown in the Spot information field. In the

example denotes J14, chip 0, i.e. a sample spot.  The other example,
, identifies J14, chip 1, i.e. a calibration spot.

The geometry file that is automatically loaded for transponder targets is shown in the

Geometry field . If a target geometry is detected during the
docking process, the Geometry field becomes read-only. The only exceptions are PAC
targets, due to the fact, that different (disposable) targets can be used on the same PAC
frame (adapter).

Figure 3-44 PAC target with selected calibration chip

During an AutoXecute run when flexControl acquires and saves data, the appearance of
the plate view gets colored. This depends on the measurement status of the spots. Two
main states are available:

l light green: MSmeasurement finished

l dark green: MS/MSmeasurement finished

Additionally five other states can be shown before and after the run.
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l yellow: preparedMS andMS/MS positions

l mauve: prepared calibration spots

l red: unsuccessful acquisition

l orange: flatline spectrum saved

l gray: MS Laser-Tuning spot

The light and dark green and red and orange states are saved when a run is finished.

If a spot is green (light or dark) this denotes that a spectrum has been acquired and saved
either automatically or manually with included path- and sample name information to a run
(see section 3.4.1.1). In both cases the measurement status has also been saved in the
AutoXecute run. This enables spectra to be sent to flexAnalysis by right- clicking the
colored sample spot.

3.5.3 Method Selection Panel

Figure 3-45 Method selection panel

Themethod selection panel performs the following functions:

l It displays the name of the currently loaded acquisitionmethod

l TheSelect button opens themethod selection dialog (see section
3.4.1.3).

l TheCalibrate button starts the automatic MS re-calibration procedure
(see section 3.7.7).
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3.6 Mass Spectrum Window

Figure 3-46 Example of a spectrum

TheMass Spectrum window (see Figure 3-46) is located top right on the GUI.  It displays
the currently acquired spectrum.

flexControl automatically normalizes the peak intensity scale. The x-axis may be scaled
with one of the three available units (see section 3.4.2.11). Pre-selection of the scale can
be performed on the menu bar by clicking the command Display > Abscissa Units (see
section 3.4.2.11).

In the upper left corner the currently active acquisition buffer (Sum/Single) can be
indicated. The setting is activated via the check boxShow legend from theProperties
dialog (see Figure 3-48).

The Mass Spectrum window can be divided in up to three windows (see Figure 3-20). 
This may be useful to simultaneously display a full spectrum and two different zoomed
areas. 

The two check boxes in the lower left corner are used for auto-scaling both the ordinate
and the abscissa.

The threeSingle scaling options below the x-axis are used to select a scalingmode (see
section 3.4.2.12).
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For enhanced viewing of data, the color of one or more objects in theMass Spectrum
window may be changed (see section 3.6.2). 

3.6.1 Scaling Pointers

To shift the currently displayed spectrum in the x- or in y-direction flexControl provides two
additional pointers:

l Horizontal Scaling pointer:

This pointer appears when the mouse pointer hovers immediately below the x-axis of the
Mass Spectrumwindow. It is used to shift the spectrum and the scale horizontally. 

l Vertical Scaling pointer:

This pointer appears when themouse pointer hovers immediately to the left of the y-axis of
theMass Spectrumwindow.  It is used to shift the spectrum and the scale vertically. 

3.6.2 Spectrum Manipulation

Right-clicking within the Mass Spectrum window opens a shortcut menu (see Figure 3-
47).  These features are used to customize the peak finder settings and the real-time
display. 

Figure 3-47 Content of the Mass Spectrum window shortcut menu

l Undo last zooming (see section 3.4.2.2):

l Processing: opens theProcessing Method Editor (see section 3.7.5).

l Properties:
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Figure 3-48 Features of the Properties dialog

The Properties dialog (see Figure 3-48) may be used to configure preferences for the
Mass Spectrumwindow(s) (see section 3.4.2.13) and to display spectra in different ways. 

l Trace Single/Sum: On selecting the respective check boxes spectra of the single
and/or sum buffer are shown in the Spectrum Window.  Clearing the boxes will
fade out the spectra. The scale of the y-axis and the trace colors are to be adjusted
in this dialog.

l Axes: A color can be specified for both the x- and y-axis.

l The buttonColor opens a dialog that is used to assign colors to the background of
theMass Spectrumwindow (see Figure 3-49).

Colors can be selected either from a set of basic colors or from a set of custom colors
which the operator can define according to their own requirements.
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Figure 3-49 The color palette

l Cross display: When selected, the spectrum is shown as a series of crosses,
each cross representing a data point.

l Line display: When selected, all data points of the spectrum are connected and
shown as a line.

l Show legend: If selected, the RTD shows which acquisition buffer is currently in
use (Sum/Single).

l Vertical labels: When selected, labels are displayed vertically. 

l Drawing Optimization : Users can activate or deactivate the Local Maximum
drawing optimization. By default this feature is activated and less noise is shown.
This is only a display setting and does not affect the spectrum.

l Split Mode: Pre-selection of how muchMass Spectrumwindows are displayed.

l Digits: Pre-selects the number of decimal places of the peak labels.
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3.7 System Configuration Segment

Depending on the currently loaded method type flexControl provides respective pages or
specific features in pages located in the SystemConfiguration segment (see Figure 3-1):

l AutoXecute (see section 3.7.1),

l Sample Carrier (see section 3.7.1.8),

l Spectrometer (see section 3.7.4),

l Detection (see section 3.7.3),

l Processing (see section 3.7.5),

l Setup (see section 3.7.12),

l Calibration (see section 3.7.6),

l LIFT (see section 3.7.9), shown if a LIFTmethod is loaded

l FAST (see section 3.7.10), shown if a FASTmethod is loaded

l SRM (see section 3.7.11), shown if an SRMmethod is loaded

l Status (see section 3.7.13)

The LIFT page (see section 3.7.9) and the LIFT Calibration page (see section 3.7.8)
appear if a flexControl LIFT method is loaded.

The FAST page (see section 3.7.10) is only available, if a FASTmethod is loaded.

TheSRM page (see section 3.7.11) is only available, if a SRMmethod is loaded before.

Note New entries in the edit fields on all pages only take effect after pressing the
ENTER key on the keyboard. The color of the new entry changes from blue to
black.
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3.7.1 AutoXecute

Figure 3-50 Features of the AutoXecute page

The AutoXecute page (see Figure 3-50) is used to create, edit and load AutoXecute
methods and runs (sequences), to start, pause and stop AutoXecute runs and to configure
some general settings concerning AutoXecute.

AutoXecute allows setup and execution of automatic runs utilizing data acquisition in
flexControl, calibration, processing and annotation in flexAnalysis, and database search in
BioTools or ProteinScape.

3.7.1.1 AutoXecute Methods

For automatic data acquisition in AutoXecute Bruker provides pre- installed write-
protected methods. These method names start with <Default> . All pre- installed
methodsmay be overwritten when a new version of the program is installed. Therefore it is
strongly recommended to use the default methods only as templates to create own
methods with user-defined names. These methods can be modified at any time and are
not touched during de-installation. The tool for AutoXecute method development is the
AutoXecute Method Editor.

The Method drop-down list on the AutoXecute page offers all available AutoXecute
methods that are stored in the correct directory (typically D:\Method\AutoXmethods).
The button opens the AutoXecute Method Editor with the selected method. It
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consists of seven pages providing a variety of functions to customize automatic data
acquisition. These functions are described in the following. To create a new AutoXecute
method, select an existing one and save it with a new name.

AutoXecute Method Editor page Description

General General settings, such asmethod selection and
comments

Laser Adjustment of the laser (FuzzyControl)

Evaluation Customize the spectra evaluation

Accumulation Customize accumulation (FuzzyControl)

Movement Specify themovement on the sample

Processing Specify post processing settings

MS/MS Setting parameters for an automaticMS/MS
measurement

AutoXecute Method

The drop-down list on the top of the AutoXecute Method Editor shows the currently
loaded AutoXecute method. The selection remains unchanged when switching between
the pages.

Figure 3-51 AutoXecute Method drop-down list

If another method should be loaded it can be selected from this list. If changes in the
current method have not been saved a warning message appears asking the user to save
the changes.
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3.7.1.1.1 General page

Figure 3-52 Content of the General page

TheGeneral page (see Figure 3-52) is used to perform general settings. 

flexControl Method

Depending on the chosen flexControl method the AutoXecute method becomes amethod
for MS or MS/MSmeasurement. Some parameters will then be disabled depending on the
selected use case. If a chosen flexControl method is no longer available on the hard drive,
its name appears in red and a warningmessage appears when the AutoXecutemethod is
saved.

For the MS use case it is possible to choose None, i.e. no flexControl method. In those
cases the method currently loaded in flexControl is used for measurement. If it is not an
MS method (but LIFT or FAST) a warning appears in the AutoXecute output and the
measurement will not start.

Description

This field can be used for comments.
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3.7.1.1.2 Laser Page

Figure 3-53 Content of the Laser page

The Laser page (see Figure 3-53) contains features to configure the laser power using the
advantage of FuzzyControl. All entries are global and valid during the entire acquisition. 

Group box Laser Power

The module Fuzzy Control works like an automatic regulation circuit. It measures and
processes two control arguments, such as peak resolution and peak intensity (S/N). As a
result it delivers two output values, in this page to optimize the laser intensity, and
accumulate spectra to the sum buffer, which are considered good enough.

In case of a MS/MSmethod, the Fuzzy Control can separately be switched on and off for
MS/Parent and fragment measurement. The required parameter settings are accessible if
a flexControl LIFT method has been selected.
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Data recording of fragmented LIFT spectra can be controlled by the Fuzzy module
analogue to the handling of MS data. Fuzzy logic for fragments handles fragmented
spectra in the samemanner as peptide fingerprint spectra.

In case of Fragment Mode Off the entered number of laser shots (edit fieldShots) will be
fired with the boosted laser power according to the LIFT page.

Weight is a parameter of the Fuzzy Control engine to scale the laser power.  It is a
configurable term of a couple of factors that are associated with the step width of the laser
power changing gradually from the Initial Laser Power to the Maximal Laser Power .
Variations are possible in minimum steps of 0.1 in the range between 0.5 and 2.0. The
values in the pre-installed default methods are the recommended ones for the respective
use cases.

Use…laser power on new raster spot

This feature is used to specify the laser power that is used on a new raster spot
(measuring position on a sample spot (see Figure 3-59)) if the current raster positionmust
be abandoned due to restrictions set in the AutoXecute method, that is, the required sum
of spectra from this sample spot has not been reached. The four possible choices are:

1. Initial: Set the laser power to the initial value for this raster spot.

This is either the value defined below (Initial Laser Power), or the one from the laser
slider in flexControl, if the check box from Laser Attenuator is selected.

2. First successful: Set the laser power to the first successful acquisition that was done
on the previous raster spot.

If there was no successful acquisition the raster spot is left but the laser power will be
increased further. For example, if you do not know the optimum laser power range,
then type a low laser power and choose First successful. Then the laser power will
be increased over several raster spots to the optimum.

3. Last Successful: Set the laser power to the last successful acquisition that was done
on the previous raster spot.

4. Locked: As soon as a shot package has been acquired successfully, this laser power
is locked and taken for all following shots until the number of required shots on the
sample spot is reached; no evaluation of the shot packages takes place. A raster spot
is left if the number of allowed shots per raster spot is reached.
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5. Last Successful: Set the laser power to the last successful acquisition that was done
on the previous raster spot.

6. Locked: As soon as a shot package has been acquired successfully, this laser power
is locked and taken for all following shots until the number of required shots on the
sample spot is reached; no evaluation of the shot packages takes place. A raster spot
is left if the number of allowed shots per raster spot is reached.

The Initial Laser Power field determines the laser power (in %) that is used to start the
acquisition on a sample spot.

The check box from Laser Attenuator can only be selected, if the Laser Fuzzy Control
is switched off. In this case the laser power is taken from the laser slider in the flexControl
GUI. The value for Initial Laser Power is then disabled.

Group box Matrix Blaster

If it is necessary to get rid of the first substance layer of a new sample spot, which shall not
be measured, the Matrix Blaster function may be used by firing a number of initial laser
shots with a specific intensity. Data obtained in this way is ignored. The default setting of 0
shots and 0 laser power means that this function is disabled.

Note This feature cannot be used together with randomwalk activated on the
Movement page.
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3.7.1.1.3 Evaluation page

Figure 3-54 Content of the Evaluation page

The pageEvaluation (see Figure 3-54) is used to configure the second output of the fuzzy
engine for peak evaluation and processing. 

Group box Peak selection

The row Use masses from x Da to y Da for evaluation and processing is used to
define amass range, which shall be evaluated duringmeasurement. This has no influence
on the acquisitionmass range defined in the flexControl method.

If some specific peaks should not be evaluated during an AutoXecute run, you have to
create amass control list, where thesemasses are defined as background (see Figure 3-
55). SinceCentroid should be used as evaluation peak detection algorithm (every isotope
is annotated) a fixed tolerance of ±2000 ppm is applied, so it is not necessary to enter all
isotopemasses in the list.
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Figure 3-55 Mass Control List Editor for AutoXecute

The background feature can also be used in the MSMSmode to exclude special masses
from LIFT measurement. Just define a MCL with masses marked as background and
select it in the AutoXecute LIFTmethod. A fixed tolerance of ±2000 ppm is then also used
and there will be noMSMSmeasurement of thesemasses.

The columnPeak label contains the names of the substances.

The columnm_z contains the theoretical values of the respective peaks.

The columnBackground contains check boxes to assign amass as background.

When aMassControl List is opened from the AutoXecutemethod editor only the
Background column is shown, even if the list contains other masses that are marked as
calibrants. Here, MCLs can only be used as background lists and not for calibration.
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Group box Peak Exclusion

If the check box is activated, the entered number of highest peaks (from the definedmass
range) is ignored during the evaluation. Again, a fixed tolerance of ±2000 ppm is used. If
an additional background list is selected, at first the background peaks are excluded, then
the x largest peaks. Detailed information is given in the AutoXecute output during the run. 

Group box Peak Evaluation

The peak finder and related parameters used for evaluation during an AutoXecute run are
offered via the Processing Methods known from flexControl and flexAnalysis. It is highly
recommended to use Centroid as peak detection algorithm instead of SNAP because
fast peak finding is required in AutoXecute runs. The signal/noise ratio of the highest peak
in one shot package must exceed the signal/noise threshold in the Processing Method,
otherwise the spectrum will be rejected. During the automatic run the Processing Method
chosen in the AutoXecutemethod is transferred to flexControl (Processing page).

Smoothing may be applied to filter out spikes from a spectrum before the fuzzy module
judges the spectrum. 

If the parameter Baseline Subtraction is applied, the baseline is subtracted before the
peak judgment operation is performed.

Note Smoothing and Baseline Subtraction are only applied for judging in
AutoXecute. If a spectrum modified in this way is accepted, the original
(unmodified) spectrum is added to the sum buffer (as known frommanual data
acquisition).

Entries in the last row concern the Peak Resolution or alternatively the Half Width of the
most prominent peak of the current spectrum (shot package). It is recommended to use
Half Width for LIFT measurements, since the Half Width of parent and fragments is
comparable, in contrast to the respective Resolutions.

Detailed information on the currently evaluated peak that is given in the AutoXecute
output, see How to read AutoXecute log.pdf in the Manuals folder of the
installation DVD.
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Group box Fuzzy Control

AutoXecute provides specific fuzzy engines for two substance classes.  One is best suited
tomeasuring peptides, the other one tomeasuring proteins. 

SelectDigest/Peptides for peptides in case of smaller molecules and high resolution. The
Signal Intensity box contains criteria to specify a kind of threshold (Intensity per shot)
peaks must exceed to be accepted. Four thresholds can be chosen: High (20), Medium
(10), Low (5) andVery Low (2). From the AutoXecuteOutput the intensity per shot can be
seen for the evaluated peak.

Example: the highest peak in a shot package that consists of 200 shots reaches an
intensity value of 1200 (y-axis). So the intensity/shot ratio is 6. In an AutoXecute run this
shot package would have been only accepted with the selected threshold Low (= 5) or
Very Low (=2).

The fuzzy engine chosen by selecting Proteins/Oligonucleotides performs best with
larger molecules and poor resolution.  To avoid identifying noise as a peak a maximal
resolution can be specified in theMaximal Resolution box.  The chosenResolution in the
row Peak above is the reference.
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3.7.1.1.4 Accumulation page

Figure 3-56 Content of the Accumulation page

The Accumulation page (see Figure 3-56) is used to determine by means of the fuzzy
engine, whether spectra are added to the sum buffer.

When Fuzzy Control is switched off, any recorded spectrum is added, regardless of its
quality. This is the same for MS/precursors and fragments in theMS/MSmode.

Note If both Fuzzy Controls (Laser & Accumulation) are switched off, a number of
settings related to shot package evaluation are automatically disabled.

If theAllow only check box is selected, the raster spot is changed after the given number
of satisfactory shots has been added.
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Note The mass range for the evaluation of the LIFT fragment spectra starts at 200
Da and ends at “parent mass – 200 Da” (default value). It can be changed in
theAutoXecute Settings dialog.

The Dynamic Termination (see Figure 3-57) feature offers the possibility to end the
acquisition on a sample spot (if the spectrum is already good enough) before the required
number of shots is reached: The already added shot packages in the sum buffer are
evaluated after each new addition. If the defined criteria (Signal/Noise or Intensity) for
the given number of peaks is reached the acquisition on this sample spot is complete. This
feature works together with the common evaluation feature. So, a sample spot will be left
as soon as one of the thresholds (Evaluation page or Early Termination) is reached.
The feature can separately be used in the MS mode as well as during MS/MS
measurement.

Figure 3-57 Activated Dynamic Termination feature
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3.7.1.1.5 Movement page

Figure 3-58 Content of the Movement page

The Movement page (see Figure 3-58) is used to specify whether the position on the
sample spot (i.e. the raster spot) has to be changed, dependent on the sample quality. The
different positions on a sample spot are named raster spots:

Figure 3-59 Sample spots and raster spots

It is possible tomeasure a sample spot with a pre-defined pattern (Measuring raster) or
with the so called Random walk, where the laser fires on randomly chosen positions on
the sample spot. All rastering features are de-activated in case ofRandom walk. To use
this feature the number of shots per raster position has to be specified.

If a Measuring raster is activated and if all raster positions of one measuring raster have
been used once, AutoXecute will restart with an additional offset at the first raster position.
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The Random walk can be used for all preparations, if it is selected all raster-related
settings are disabled. When random walk is used during autoXecute runs it is not possible
to choose between Partial sample and Complete sample, as known from the manual
measurement (see section 3.7.2), themovement is done withComplete sample. .

When theMaximal allowed shot number at one raster position is reached, the target
moves to the next measure position (raster spot) on the same sample spot to continue with
the acquisition.

However, if the check box Ignore maximal shot number if signal is still good is
activated the measurement will be continued as long as the evaluation considers spectra
as good enough.

TheMaximal allowed shot number and Ignore maximal shots can both be separately
used for precursors and fragments in an AutoXecute LIFTmethod.

The Quit sample after box is used to set a criterion to abort an acquisition on a sample
spot. When themaximal number of subsequently failed judgments has been reached, the
sample on the entire sample spot is considered unusable for data accumulation. The
target moves to the next sample spot.

3.7.1.1.6 Processing Page

Figure 3-60 Content of the Processing page

TheProcessing page (see Figure 3-60) is used to specify different available methods for
post processing. 
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Note It is recommended to specify the post processing methods in the AutoXecute
Run editor and not here in the AutoXecuteMethod Editor. Nevertheless there
are few use cases (e.g. flexImaging, WARP-LC), which require to specify the
methods in the AutoXecute Method Editor. In case methods are specified in
both the Run editor and in the referenced AutoXecute methods, the settings
from the Run editor are taken.

The flexAnalysis Method , BioTools MS Method , and BioTools MSMS Method
boxes allow choosing one of the offered methods for post processing. If a method is
chosen the method name is entered as information in the parameters of the saved
spectrum (FAMeth and BTMeth). During an automatic run a spectrum is only sent to
flexAnalysis and BioTools, if a respectivemethod is assigned (either here or via the
RunEditor).
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3.7.1.1.7 MS/MS Page

Figure 3-61 Content of the MS/MS page

If a flexControl LIFT or FAST method is loaded in the General page, the MS/MS page
becomes activated. It is used to determine the LIFT and FASTmeasurements on the basis
of the respective fingerprint information.

The main decision on this page is done with the Precursor Selection strategy . For
automatic MS/MS measurements MS measurement must be done on a sample spot
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before because it is essential to have MS fingerprint peak lists where special peaks are
selected from. Two possibilities are offered to select these peaks from theMS peak list:

1. WARP (feedback from BioTools or ProteinScape): BioTools (version 3.0 and
higher) or ProteinScape mark peaks in the MS peak list and sort this peak list.
AutoXecute then only reads this information and starts the MS/MS acquisition and
evaluation without any further filtering. If WARP is chosen, the rest of theMS/MS page
is not used and therefore de-activated (see section A.1). WARP-LC users have to use
this precursor selection strategy.

2. Filter and Sort (via AutoXecute): AutoXecute reads theMS fingerprint peak list and
marks peaks for MS/MS, according to the filter criteria that are adjusted in the
Precursor Filter group box. If this option is chosen, MS spectra can naturally also be
sent to BioTools, but theMascot result for these spectra does not affect theMS/MS
measurement.

If you want to select the precursor masses from the MS peak list manually a different
workflow has to be done. Please refer to the Quickstart document Quickstart_
PrecursorSelection.pdf on the installation DVD.

Due to the process of a MS/MS-measurement there is a mass range with optimal
fragmentation properties. This behavior is addressed withPrecursor Mass Range
Selection. Peaks in the Primary Choice Mass Range are preferred fragmentation
targets. Only if there are too few peaks in the primary mass range after filtering, the peak
list is gradually filled up from the Secondary Choice Mass Range. So the primarymass
range is always included in the secondarymass range.

All parameters contained in the Precursor Filters box can be individually selected. They
form a filter to ensure that only the best suitable precursors are taken for ameasurement.
The higher the values of the three parameters are set, the narrower is the bandwidth
surrounding the precursor.

l Select the number of MS/MSmeasurements withNumber of Precursor Masses.
The selectedmasseswill be listed in the AutoXecute output.

l WithPeak Intensity higher than all peakswith lower intensity will be sorted out.

l With Peak Quality factor higher than all peaks with lower quality factor will be
sorted out.

l WithSignal/Noise higher than all peakswith lower S/N will be sorted out.
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The information on the filtering steps during the run is shown in detail in the AutoXecute
output. If you want to check the filter process you may load the MS spectrum manually in
flexAnalysis and filter the peak list step by step on your own.

In the Advanced section (see Figure 3-62) a fourth filter,Near Neighbor, is offered with
its belonging settings. It ensures that if peaks are in close proximity (ion selector window)
of a possible precursor none of them is taken as precursor. The lower and upper limits
define themasswindow where no other peakmust be detected.

There is an additional peak excluding filter available that can only be activated via the
Evaluation tab of the autoXecute MSMS method: select a Mass Control List, where the
masses that you want to ignore for MSMS precursor selection aremarked as
Background peaks.

A valid precursor must have at least the defined intensity (regarding his near neighbors) to
be analyzed.

Figure 3-62 Precursor Filter - Advanced

Depending on the selected option in Precursor Measuring Order the MS/MS
measurement begins with the intensive or the small peaks first.

In case of an AutoXecute FAST measurement the minimal Fragment mass , that
determines the number of segments can be entered here and is transferred to flexControl
during the run.

The LIFT option Measure Fragments only can be used e.g. for MALDI Imaging
experiments. For more information, see the FlexImaging User Manual.

3.7.1.2 Run Method on Current Spot

To test the settings of an AutoXecutemethod the button can be used.
Automatic data acquisition starts on the current spot with the currently selected
AutoXecute method, but data is not saved automatically in the end. The flexControl
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method loaded in the GUI has to fit to the AutoXecute method (both MS, or both LIFT).
Otherwise a message appears in the AutoXecute output (see Figure 3-63) and the
acquisition does not start.

Figure 3-63 AutoXecuteoutput with error message

3.7.1.3 AutoXecuteRun

AutoXecute runs (sequences) are created with theRun Editor that is part of flexControl,
but can also be used as stand alone program. An AutoXecute Run defines the workflow
on every prepared target spot, i.e. what to measure (MS, MS/MS), where to save the data
and which post processing is done.

After an AutoXecute run is finished the measurement status for each spot has
automatically been transferred to the sequence. It can be seen in the sequence file,
columnStatus (see Figure 3-66), as well as on the plate view (colored circles, (see Figure
3-73). A run that has been finished cannot be started again without resetting the status. If
you try to start an already finished run, the AutoXecute output indicates that no
measurement position is available by displaying the message 0 positions loaded

(see Figure 3-64). To run the sequence again the status for MS and/or MS/MS has to be
reset in theRun Editor (see Figure 3-66).
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Figure 3-64 A finished run has been re-started without resetting the status

A list of the last used sequences is offered in the drop down box Run (see Figure 3-50).
The number of sequences shown depends on the setting in the AutoXecute Settings
dialog (see Figure 3-74). A selected sequence results automatically in visible colored
circles on the Plate View.When you select none a plain plate view is shown.

The button is used to load sequences that are not offered in the drop down list. It
is also possible to load old sequence files (.txt) that have been created with the Excel
based Spreadsheet Generator. It is not possible to load a run that was created for a target
geometry that does not match to the target that is currently in the instrument. A message
appears (The referenced geometry of the run does not fit to the geometry type of your
target). To load this run, insert the correct target first.

The button is used to open theRun Editor with the currently selected sequence
file. If a txt file (spreadsheet generator generated) is selected it will be imported, the
appearing message (see Figure 3-65) has to be confirmed. Methods, paths, sample
names and comments will be transferred from the txt file to the Run Editor. If any
method is not available it will be shown in red.

Figure 3-65 Import a spreadsheet generator created sequence

An AutoXecute run is started with the button . At the beginning the
methods used in the run are selected. If a file is missing, the run stops and a message is
given in the AutoXecute output.
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During an AutoXecute run it is not possible to change any settings in either the AutoXecute
methods or the sequence file. If you want to have a look to themethod content, the run can

be paused with the button from the output window or the AutoXecute page.
The Method Editor as well as the Run Editor can then be opened in the view mode
where nothing can be changed. To continue click .

A run can be stopped at any time and position. When it is restarted it continues on the spot
where it has been stopped before (due to theStatus information), no information is lost. If
you want to restart a run from the beginning the Status has to be cleared and it is
recommended to delete the alreadymeasured spectra from the hard drive.

3.7.1.4 The AutoXecute Run Editor

The button starts the Run Editor wizard (if activated) or opens theRun Editor

immediately (like the button does). If you want to setup a run with calibration
measurement aswell as samplemeasurement youmust use the wizard. The explanations
in the wizard and in the help file and theAutoXecute Run Editor Manual are very detailed;
therefore not much additional information is given here.

As denoted before, the status of a spot is shown in the sequence file. If the status is
finished (light/dark green) but you want to measure the spot again, it is necessary to clear
the status and save the sequence.

Figure 3-66 Status of a sample spot

In earlier flexControl versions where sequences had to be created with the spreadsheet
generator some templates were offered, especially for the calibration use case. With the
new Run Editor calibration templates are pre- installed for a lot of different target
geometries. Additionally you can create your own calibration templates in the wizard. After
you chose to work with a calibration template the Calibration Mode is automatically
activated in the Run Editor wizard (see Figure 3-67) or the Run Parameter page (see
Figure 3-68).
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According to the loaded geometry the matching pre- defined or own user- defined
calibration template is offered.

Figure 3-67 Activated calibration mode in the
wizard

Figure 3-68 Activated calibration
mode in the Run
Editor GUI

3.7.1.5 Show AutoXecute Output

Selecting the Show AutoXecute Output check box opens the AutoXecute output
window (see Figure 3-69) where detailed information concerning the current AutoXecute
run is shown. In the beginning the complete version numbers of the programs are listed,
afterwards follows the method check that assures that all selected methods from the run
are available on the hard drive.

During the run a lot of information concerning laser power setting, peak evaluation etc is
displayed. If errors occur they will be shown in red, successful evaluations are shown
green colored. More information on how to interpret the fuzzy engine results (fuzzy
input/output) are given in How to read AutoXecute log.pdf on the Compass for
flex DVD.

A run can be paused and continued with the button / and aborted
with . Information on these actions are shown in the output.

The content of the AutoXecute OutputWindow is also saved on the hard drive in the file
C:\BDALSystemData\AutoXOutput.txt. 
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Figure 3-69 AutoXecute output
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3.7.1.6 Show Process Queuer

Selecting theShow Process Queuer check box opens the ProcessQueuer window (see
Figure 3-70) . The Process Queuer window shows information about spectra being
processed in the background by flexAnalysis. This information contains the list of spectra
being currently processed and information about the result of the processing. For details
please refer to the flexAnalysis User Manual.

Figure 3-70 ProcessQueuer Window
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3.7.1.7 Settings

The button opens theAutoXecute Settings dialog (see Figure 3-71) that helps
to configure some general AutoXecute settings that do not need to be changed for every
run.

Note After changes have been done in this dialog flexControl has to be re-started to
be able to work with the new settings!

Figure 3-71 AutoXecute Settings – AutoX

Precursor selection in WARP use case

If theWARP use case is selected in theMS/MS AutoXecutemethod (section 3.7.1.1 and
3.7.1.1, page MS/MS), an external program like BioTools or ProteinScape selects the
masses for later MS/MSmeasurement. In this dialog the respective Feedback option has
to be chosen to determine to work with either of these programs.

TheWait time applies only for BioTools. It specifies how long AutoXecute waits for the
modified fingerprint peak list. If after this time no peak list is available for the current sample
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spot, AutoXecute continues with the next spot. Since common AutoXecute runs consist of
more than a few spots, and first all MS measurements are done, BioTools or
ProteinScape will normally have enough time to modify the MS peak lists. So, if
AutoXecute starts with MS/MS, theMS information are available.

If ProteinScape has not been finished when AutoXecute starts with MS/MS the run stops
immediately without anywait time.

Note In case BioTools or ProteinScape are not ready when AutoXecute wants to
start the MS/MS measurement, the run ends without MS/MS. Afterwards,
when the necessary modifications from BioTools or ProteinScape are
available, i.e. peaks are marked, it is possible to simply re-start the run with
measureMS/MS only.

Misc action during AutoXecute run

The Misc action during AutoXecute run group is used to define the time period the
high voltage is switched on before starting the acquisition to put the instrument into a
stable state.  After a complete run the high voltage might be turned off by selecting the
corresponding option.

Additionally an acquisition method may be loaded to prepare the mass spectrometer for
the next run. If none is chosen for the flexControl method after a run, the last method
loaded during the run remains in flexControl.
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Figure 3-72 AutoXecute Settings – AutoXecute- Advanced

The Advanced section contains settings that should not be changed without exact
knowledge (if questions occur, ask maldi.sw.support@bdal.de ).
If changes have been done but you are not sure, the pre-defined settings can be restored

with the button .

Behavior after unsuccessful acquired spectrum

Different save results are achieved, depending on the status combination of the check box
Enforce Shots and the threeSave options. The results of the combinations are displayed
in the following two tables. The colors correspond to the colors shown on the plate view
(see Figure 3-73) after the run has been finished.
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1. Enforce Shots is selected (i.e. the requested number of successfully added shots has
to be reached).

Save
zeroline

Save sum of
rejected

Do not save

No shot package is summed Zeroline Zeroline Nothing
saved

Some shot packages are
summed

Zeroline Zeroline Nothing
saved

2. Enforce Shots is cleared, i.e. it is not necessary to have all requested shots in the
end. Therefore you have to differentiate between ‘some shots have been added’ and
‘no shots have been added’: 

Save zeroline Save sum of
rejected

Do not save

No shot package is
summed

Zeroline Sum of rejected Nothing saved

Some shot packages
are summed

Sum of
successfully added

Sum of
successfully added

Sum of
successfully added

The plate view may look as follows:

Figure 3-73 Plate view with colored results

Notification

After a spectrum has been saved or the measurement on a whole target is finished it is
possible to get a notification on another server.
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Dynamic Termination

This setting concerns the Early Termination feature from theAccumulation page in the
AutoXecute Method Editor (Figure 3-57), where it is possible to finish the accumulation
on a sample spot if a defined number of peaks have reached a defined Signal/Noise
value. Here you can specify the number of shots that has to be added at least before the
Early Termination feature is allowed to end the acquisition as soon as the other criteria
are reached.

LIFT Fragments Evaluation Mass Range

During the automatic measurement of LIFT fragment spectra these values determine the
respectivemass range where peaks are used from for evaluation.

Target to run assignment

Activate this check box, if you want to use the MasterBatchList. Normally this is only used
in conjunction with the Twister use.

History count

TheHistory count determines the number of runs that is offered in the drop down box
AutoXecuteRun (see Figure 3-50).

Figure 3-74 AutoXecute Settings – AutoXecuteRun
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3.7.1.8 Set Initial Laser Power

If you don't know which laser power to use in the beginning of an AutoXecute run you can
adjust the initial laser power before or during an AutoXecute run by pressing the button

. Just follow the steps below:

1. Pause the run.

2. Adjust the laser power with the slide.

3. Resume the run.

The initial laser power, which is usually taken from the Laser page of the currently used
AutoXecutemethod or from the automatic laser power tuning in the beginning of a run, is
ignored. Additionally the maximum laser power value is adjusted accordingly. Both
settings (new initial laser power and new maximum laser power) are only stored  for this
AutoXecute run. Thismeans the usedmethodswill not be changed. If you choose another
run from the drop-down box, the initial andmaximum laser power values are deleted, and
the values from the AutoXecutemethods are used again.

3.7.2 Sample Carrier

Figure 3-75 Features of the Sample Carrier page
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TheSample Carrier page (see Figure 3-75) is used to configure target plate features. On
the top the Teaching File is shown that belongs to the currently loaded target geometry
(see Figure 3-43).

The button loads the default teaching file (named default.teach in the
respective teachings directory for the current target plate, e.g.
D:\Methods\GeometryFiles\MTP AnchorChip 200- 1536_ teachings )
corresponding to the currently loaded target plate.

Auto teaching is an alignment procedure to automatically guide AnchorChip targets after

docking into the best measure position. The button starts the auto
teaching process. If no auto teaching target is inserted a message appears and the
process stops.

The button opens the Teaching dialog (see section 3.7.2.1).

TheAutomation group box contains elements that are used to configure workflow related
actions. Depending on the options installed on the instrument, elements will be hidden, so
that they cannot be set unintentionally.

Note If the Perform Autoteaching on Dock- In option is selected, the auto
teaching process is performedwhenever the target plate is changed, and if the
target is identified as an AnchorChip type.

The button opens the group boxManual Fine Control (see Figure 3-76).
Clicking the symbol in the center of the arrangement of arrows activates the keyboard
cursors tomove the tray. This option allows a sharp and exact move across a sample spot.
A second way to alter a position on the spot is to enter corresponding values of the x-y-
parameters entry fields on the right.
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Figure 3-76 Manual control on teaching dialog

3.7.2.1 Teaching Dialog

Teaching is an alignment procedure to compensate possible mechanical tolerances of the
sample loading facility.
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Figure 3-77 Features of the teaching dialog

The Teach Positions dialog (see Figure 3-77) appears for realignment. To perform a

teaching select the First Position and click . When the target has been moved to

this position, click and continue with the Second Position. The new absolute
coordinateswill be calculated automatically.

When the group box Status acknowledges with OK quit with the button. The
record of the new x- y- coordinates is finished and sent to the transponder in case of
transponder targets, if the check boxSave this teaching to Transponder is selected.

Use the button before teaching to eliminate possible step losses. The task
of the button is to re- define the zero point of the x- y- coordinates. The button

loads a file containing factory defaults of the target. The buttons

and are used to handle <name>.teach files, either
to reload a stored file or to store a current file with a specific name. The

button saves the current teaching as default teaching, so that it is
automatically loaded when a target plate with the same type is loaded for the next time.
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3.7.2.2 RandomWalk

The Random walk feature can either be used during manual measurement but also
during automatic data acquisition (section 3.7.1, Movement page ). It allows to measure
on randomly selected raster positions.

SelectMode Off if you want to choose themeasuring positions on your own.

If you select Partial sample, only a small area around the actual chosen raster position in
the video is used for data acquisition.

Note In automatic modePartial sample cannot be used – complete sample is used
instead if theRandom walk is activated.

WithComplete Sample selected the laser fires on the whole sample spot.

Shots on a raster spot determine the number of shots that is fired on every randomly
selected position.

The Limit diameter to field allows a temporary reduction of the sample spot diameter for
manual measurements. The original sample spot diameter is restored e.g. on chip change
or when a new target plate is inserted.

3.7.3 Detection

Figure 3-78 Features of the Detection page
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TheDetection page (see Figure 3-78) is used to re-adjust acquisition parameters, e.g., to
configure themass scale, or to vary the amplification factor of the detector.

Themass range is changed bymoving the thumbs of themass range slider.

The total mass range of 500,000 Da is divided into three sub ranges called Low Mass
Range, Medium Mass Range, and High Mass Range. Anyone can be independently
configured according to the application. This configuration comprises the definition of the
start and endmass and the linear or logarithmic scaling of the range or sub ranges.

To configure a mass range select the Define Range item in themass range drop list (see
section 3.7.3.1).

Figure 3-79 Mass Range drop-down list

Sometimes the S/N ratio of the acquired data requires an adaptation of the detector gain.
The slider is used to adapt the amplification factor. The function of the slider corresponds
to that of the edit fieldReflector Detector Gain in the FAST Method Editor (see section
3.7.10.1). A changemade in one of both features is simultaneously adopted by the other
one.

The parameters Resolution and Mass Range of the group box Sample Rate correlate
in a way that an increase of the Sample Rate causes an increase of the resolution and a
decrease of themass range (digitizer performance). To illustrate this, the invalid part of the
mass range selector becomes red in color.

Realtime Smoothing reduces the bandwidth of the digitizer preamplifier. Depending on
your digitizer type theDetection page contains a number of entries in the drop list (on/off,
off/low/medium/high). If this entry is disabled, the instrument has no provision for real-
time smoothing. This function is the same as that selectable by the FAST Method Editor
(see section 3.7.10.1).

TheBaseline Offset Adjustment box allows to fine tune the analog offset for the digitizer
for the current flexControl method. The percentage is applied to half the digitizer
sensitivity, the result analog offset is displayed in the field below. The percentage value is
stored in the flexControl method.
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If the instrument is equipped with a smartbeam laser, the smartbeam parameter set

selection drop list allows to select a certain parameter set
depending on the sample and preparation type to analyze. This setting is stored in the
flexControl method.

The Frequency box duplicates the function of the corresponding element on the
Acquisition Control (see section 3.5.1). It adjusts the laser trigger frequency. Higher
frequencies result in faster data acquisition.

Certain flexSeriesmass spectrometers are equipped with a High Mass detector instead of
the standard MCP (Multi Channel Plate) detector . Operating in linear mode (linear
method is loaded) with a High Mass instrument means that additional High Mass
parameters appear on the Detection page (see Figure 3-80). High Mass detectors have
an additional acceleration electrode, which operates best at a voltage of 8–10 kV. The task
of this electrode is to accelerate secondary electrons.

Figure 3-80 Features of the Detection page with installed Highmass detector

The check box Turbo available on certain instruments adapts the detector sensitivity for
masses beyond 10 kDa (polymers). It is up to the operator to experiment with these
settings for the best performance.
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3.7.3.1 Mass Range Selector

The Mass Range Selector dialog is used to configure any of the three mass ranges.
Concerning the layout all the boxes correspond to each other. They contain identical
functions.

To customize the range corresponding values have to be entered into the Lower Limit
and Upper Limit fields. The beginning or end of the Medium Mass Range can overlap
the adjacent mass ranges. A mass range may be displayed as a whole, in linear mode, or
logarithmicmode aswell. A combination of both scales can be also performed at the user’s
discretion by entering a value into the field Upper Limit of Linear scale. The value in
Linear Display Portion defines how both scales share the range.

Scale marking of a range can be performed by setting values, where ticks shall appear.
Ticks may be assigned with a mass value to enhance viewing. The repetition rate of this
assignment is associated with the factor in the entry field Ticks with Text Repetition
Factor in the logarithmic portion.

To adopt all the new entries press the button.
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Figure 3-81 Configuring the mass ranges
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3.7.4 Spectrometer

Figure 3-82 Features of the Spectrometer page (reflector method)

TheSpectrometer page (see Figure 3-82) is used to configure the ion optics. According
to the loadedmethod this page offers specific features. 

The toggle key | is used to switch on or off following components,
depending on the loadedmethod:

l Ion Source 1,

l Ion Source 2,

l Lens,

l Reflector,

l Reflector 2,

l LIFT,

l LIFT 2.

The status field | right beside the |
button is the corresponding feedback, whether the HV-supply is ready or not.  In case of a
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bad vacuum, or when the instrument is vented this field toggles to (high
voltage is definitely off) independent of the switch position. 

Below the toggle buttons are edit fields to adjust voltages for the target plate (ion source
1), the electrode P2 (ion source 2), and the lens arrangement.  The unavailable fields
reflect the actual measured values for diagnostics. They may deviate and fluctuate, as
threshold values are not very accurate.

Selecting the box set relative activates the two%IS1 boxes . The upper box is used to
adjust the IS2 value relative to IS1. The lower box is used to set the lens voltage relative to
IS1.  These two adjustments may be varied to get good results in resolution and
sensitivity. 

The value for Pulsed Ion Extraction is the delaymeasured in ns between the laser shot
and themoment when the electrode P2 is pulsed down to let the ions pass. 

The current polarity is shown by one of the unavailable fields | .
You can change the polarity in the program flexConfigurator under flexControl Misc.

Matrix Suppression is a feature useful for suppressing matrix components of a
compound and avoiding saturation effects of the detector. If the optionOff inside the group
boxMode is not applied either the button Deflection or the buttonGating (available in the
linear mode) becomes active.

Thematrix deflection process is performed inside the ion source by coupling a pulse to the
related deflection plate. The pulse length corresponds to the mass entered into the field
Suppress up to. The mass entered here specifies the upper mass boundary, below
whichmass ions are suppressed.

The gating process occurs inside the linear detector by applying fractions of the supply
voltage for few µs to the first channel plate of the detector. A couple of ms later the voltage
returns back to its nominal value.   

flexControl detects instruments that do not have an ion source with deflection electrodes,
such as the microflex. The program automatically uses for deflection either the PCIS or
PLMS (tandem spectrometers) electrode. 

Setting a second reflector voltage (Reflector 2) is required using an ultraflex TOF/TOF
spectrometer. 
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If the check box set relative is activated the second reflector voltage can be adjusted in
the box%Refl. as a percentage of the first reflector voltage. In reflector mode, only the
Deflection option is available for matrix suppression.

All methods that are used for data acquisition should have a so called valid calibration, i.e.
the access to all the entry fields is deactivated. If the user wants to change voltage settings,

theymust apply the button. Then themessage below appears. 

Figure 3-83 Warning

Clicking OK releases the edit fields for new voltage adjustments.  This action requires a
new calibration of themethod, that is accepted by clicking theApply button (see section
3.7.6). 

In case of a tandemmass spectrometer and a loaded LIFTmethod the content of the
Spectrometer page changes (see Figure 3-84). Compared to the previous example (see
Figure 3-82) the voltages for the additional two LIFT-electrodes are available.

Figure 3-84 Features of the Spectrometer page in case of a LIFT method
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3.7.5 Processing

Figure 3-85 The Processing page

The Processing page (see Figure 3-85) offers access to the processing parameter
methods that contain the currently active peak picking and processing settings. Processing
methods (*.prp ) are used, created and changed from flexControl, flexAnalysis and
AutoXecute. If a processing method is edited in one of these programs the changes are
immediately available in the other programs.

A Processing method is part of the flexControl method in a way that the flexControl
method contains a reference to a Processing method. If a new Processing method is
selected, this is detected as change of the FC method that has to be saved then. If a
parameter in the current Processing method is changed only the Processing method has
to be saved, the FC method does not notice this change.

The processing method that is loaded with a flexControl method defines the peak picking
algorithm that is used for manual calibration and annotation in the display, as well as the
algorithms and parameters that are used for manual baseline subtraction and smoothing.

Whenmethods created and used with a flexControl version 2.x are loaded the first time in
flexControl 3.4, a processing method is automatically created and the old processing
parameters are transferred into a processing method. The new parameters get the name
of the flexControl method. For more information see the Quickstart_
ProcessingParameter.pdf on the Compass for flex DVD.

Existing processing methods can be edited and new processing methods can be created

on the basis of the pre-installed default method. With the buttons the
Processing Method Editor (Figure 3-86) opens. The sectionMass List > Find covers
the settings for the peak picking algorithm. Smoothing and baseline subtraction can be
adjusted in the Processing section. The section Mass List > Edit is not relevant for
flexControl and AutoXecute, but only for flexAnalysis.
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Note The processing settings used in flexControl during the data acquisition are not
saved with the spectrum and are not automatically available in flexAnalysis
afterwards. This parameter set is only used in flexControl. The assignment of
special processing parameters to a spectrum has to be done via the
flexAnalysismethod like this:

1. Create a flexAnalysis method with a reference to your special processing parameter
method (see the flexAnalysis User Manual).

2. Acquire a spectrum in flexControl and open theSave As dialog (3.4.1).

3. Select the special flexAnalysismethodProcess with and save the spectrum.

4. Send the spectrum to flexAnalysis. The assigned method with the respective
processing parameters will be applied automatically.

For data acquisition in flexControl and evaluation during automatic runs the recommended
peak finder isCentroid. Using SNAP will only extend the processing time but not improve
the spectra quality.SNAP should be used later on in flexAnalysis for creating peak lists in
the peptidemass range.

Three different smoothing algorithms are offered. Which one is used depends on the
application and on the user’s experience.

The baseline subtraction algorithm TopHat should be used for all spectra except for
protein spectra. For this use caseMedian is recommended.

For detailed information on the peak picking, smoothing and baseline subtraction
algorithms, see the flexAnalysis User Manual.
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Figure 3-86 Processing Parameter Editor

3.7.6 Calibration (non-LIFT Method)

TheCalibration dialog (see Figure 3-87) appears in case of a non-LIFTmethod. The
Calibration page is used to recalibrate the method.  During the calibration, particular
masses of the acquired mass spectrum are assigned to reference masses of the loaded
calibration list (depending on the calibration strategy).

flexControl offers three calibration strategies:

l Interactive calibration, done automatically or manually, using calibration lists
(MCLs).

l Smart, that is an easy- to- use calibration procedure for optimum results. The
program reappraises the statistical frequency of occurrence of calibrants.

l Statistical calibration for peptide spectra.
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Interactive Calibration

In the Interactive mode the operator can choose between automatic ( ) or
manual (click in the list) assignment of referencemass peaks.

Depending on themass range (seeMass Range slider on theDetection tab)Automatic
Assign uses different peakfinders to create the peak list that is used for the calibration:

a. SNAP is used automatically in themass range up to 6000 Da

b. in the higher mass range the peak finder currently selected in the active processing
parameters is used (mostlyCentroid).

If themasses are assignedmanually, the peak detection algorithm that is currently chosen
in theProcessing Parameter Editor is used.

To assign the masses manually to the calibrants, click in the list and afterwards in the
spectrum left to the corresponding peak (it is not necessary to hit exactly the top of the
peak, just click left to it, the correct peak will be found). Masses are automatically
transferred to the calibration list. You may use the scroll wheel of your mouse for further
manual assignments.

The calibrant list shows names and masses of known substances, the corresponding
masses found in the currently active spectrum, and the error in ppm and in Dalton. The
error is re-calculated with each new assignment. The error in Dalton is calculated with
current mass reference mass( − ) , the error in ppm is calculated with

× 10
current mass reference mass

reference mass

( − ) 6

.
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Figure 3-87 Features of the Calibration page

Mass Control List selection: This drop-downmenu contains all mass control lists (MCLs)
where at least one mass is marked as calibrant. Only the masses marked as calibrants of
the selected list are displayed in the box below, the others are invisible in the calibration
context.

Button : Applying this button opens theMass Control List Editor (see Figure 3-
88). Calibration lists can be changed and created from here, as well as from AutoXecute
from flexAnalysis. Pre-installed lists are write protected but can be used as templates for
own user created lists. Whole peak lists (peak list.xml) can be imported to use the
masses as calibrants.

For more detailed information onmass control lists see Quickstart_
MassControlLists.pdf on the CompassDVD.

Note If the Mass Control List Editor is opened from flexControl it shows only the
possibility to markmasses as calibrants (columnCalibrant). The column
Background is not offered here, because flexControl only works with
calibration lists. If your MCL of interest contains masses that are used as
calibrants and as background peaks (activated via AutoXecute or in
flexAnalysis), both check marks are active, but theBackground checkmark is
invisible (compare section 3.7.1.1, Evaluation tab).
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Figure 3-88 Mass Control List Editor

: Peaks from the spectrum are automatically assigned to the reference
masses; a new fit result and errors are calculated but not yet applied to the spectrum. The
peak finder algorithm used for automatic calculation isSNAP for amass range < 6000 Da.
This value can be changed in the flex Configuration dialog (see Figure 3-89). For a
mass range > 6000 Da the peak finder algorithm from the processing parameters is used.
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Figure 3-89 flex Configuration dialog

: With a click on this button the new fit result, calculated with the button
Automatic Assign or manual assignment is applied to the spectrum (the spectrum is
moved in the display).

: After the new fit result has been applied with Calibrate this can be
canceled with theUndo button. The original calibration, currently saved in the spectrum, is
applied again and peaks are re-annotated.

: This button deletes the assignments from the calibration list; it does not
affect any existing calibration.

: For manual assignment of masses to reference masses it
is necessary to click in the spectrum to the left of the peak of interest. Therefore it is helpful
to zoom automatically the respectivemass range corresponding to the selected reference
mass. It is possible to choose between some relative and absolute zoom ranges.
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Note You can use themouse wheel to select the next reference mass (or to go back
to a previous one). This simplifies themanual assignment.

Peak Assignment Tolerance: The tolerance defines a mass interval that is used for the
calibrant assignment. If the difference between a reference mass and a peak in the peak
list is smaller than the tolerance, the peak is assigned to the calibrant. If more than one
peak of the peak list fits this criterion the peak with the smallest mass difference to the
calibrant is assigned to the calibrant. Therefore be careful with accepting automatically
created calibration results without having checked them!

Mode: This drop down box offers the three calibrationmodes; linear (c0, c1, c2=0),
quadratic, and cubic enhanced, as well as the correctionmode linear correction.

Cubic enhanced is a proprietary Bruker calibration algorithm. In contrast to the classical
quadratic approach, it provides three special and additional degrees of freedom for the
calibration least square fit. These additional fit coefficients allow matching the instrument
function down to sub ppm accuracy.

It should be used whenever the required number of supporting points is available because
it will deliver superior accuracy. The Cubic Enhanced algorithm should replace the
previousHigh precision calibration (HPC) which was used for high accuracy before. In
contrast to the HPC, the cubic enhanced algorithm needs fewer coefficients but provides
better accuracy and better extrapolation at the same time.

Typical use cases for highest precision use one or two internal calibrants. These two
supporting points do not allow to locally recalibrate all coefficients. However, readjusting
the main coefficient corrects almost all deviations that appear from one spectrum to the
next. Therefore, Linear correction allows using one or a few supporting points, i.e.
internal calibrants, to recalibrate the complete spectrum very accurate. All higher
coefficients are kept constant, only the new calibrants are used in a least square fit to
realign the dominating coefficient.

Note When themode cubic enhanced is chosen the HPC calibration gets lost and
a message box containing this information appears. Just confirm this dialog
withOK, accept the new calibration and save themethod with a new name (no
HPC-information)!!

: TheProperties dialog shows the current state of the calibration and some
general calibration information. If spectra have been acquired with a flexControl HPC
method the check box High Precision Calibration applied at the bottom (read-only
check box) is activated.
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Figure 3-90 Properties dialog (same as in flexAnalysis)

Result Information: Below the calibration list three result fields are shown: the number of
used calibrants, the standard deviation before and standard deviation after the last
calibration fit.

If no peaks are found during the peak assignment the followingmessage appears.

Figure 3-91 Calibration failure

To redo the calibration perform the offered changes or open the processing method and
change for exampleS/N. Save and close themethod an calibrate again.

flexControl 3.4 User Manual Revision 1 Page 109 of 166



3 Graphical User Interface (GUI) Bruker Daltonik GmbH

►► Short workflow for the Manual Calibration

1. Acquire some spectra containing the masses, which are also calibrants in the selected
mass control list and add the spectra to the sum buffer. The peaksmust not be
saturated!

2. Click the button or select a Zooming Factor of for example 1% and
markwith the left mouse button the first mass from the reference list, which is present
in your sample.

The selectedmass is displayed as a red vertical line in the display.

3. Click to the left of the peak that corresponds to the selected mass of the reference
mass list.

The line becomes green and the mass value is labeled at the top of the peak. The
Current Mass and the Error is added to the corresponding column in the mass
control list. The corresponding calibration constantsC0 –C2 are displayed in the
Properties dialog.

4. Continue with the followingmasses by using the scroll function of your mouse. This has
the advantage that you first may have a look on the actual labeled current mass and
scroll then to the next (or the previous) referencemass.

After assigning amass, the corresponding row ismarked with a checkmark.

3.7.7 Automatic MS Recalibration

The automatic MS re-calibration feature performs an automated re- calibration of the
current flexControl method. To use this feature, move the sample carrier to a spot with a
calibration substance matching the current mass control list, make sure that the
parameters were set to reasonable values (see section 3.4.4.7) and click the Calibrate

button on themethod selection panel.

The software then performs the automatic MS re- calibration process and displays the
results in the autoXecute output window.
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►► The automatic MS re-calibration involves the following steps:

1. Acquire a spectrum using the autoXecute method specified in the Method
Calibration Parameters dialog.

Optional: Smooth the spectrum.

1. Peak picking using the current processing parameters, some can be overridden by the
method calibration parameters.

2. Automatic peak assignment using the mass control list and tolerance from the
Calibration > Property page.

3. Calculation of new calibration using the algorithm specified on theCalibration >
Property page.

4. Accept or reject new calibration based on boundary conditions specified in theMethod
Calibration Parameters dialog.

5. Optionally save flexControl method containing new calibration and inform user.

A typical result of the automaticMS re-calibration is shown below (see Figure 3-92).

After the automatic calibration has been done once successfully with a matching selection
of parameters (see section 3.4.4.7) , these parameters are stored together with the
flexControl method. This allowsworking with different parameters for different flexControl
methods, and it is not necessary to adjust them every time again before a new auto-
calibration is started.
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Figure 3-92 Result output for automatic MS re-calibration

3.7.8 Calibration (LIFT Method)

When a LIFTmethod is loaded theCalibration page looks as shown in the following
example (see Figure 3-93). Calibration coefficients in LIFT applications are only valid over
a small mass range in contrast to coefficients in standard applications, which are valid over
a wider mass range. Therefore LIFT applications need several sets of calibration
coefficients to cover a wider mass range. It is only necessary to calibrate a LIFT method
once, if no changes on the instrument took place. After the calibration it is not possible to
change themethod, because it is shown in a write protected "valid mode".
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Calibration coefficient sets are achieved by calibrating the fragment spectrum of one
parent substance, called calibrant in this context. Collecting calibrants together with their
associated calibration coefficients is performed by means of the Calibration page.  This
collection is stored in themethod file. Thus, each LIFTmethod gets its particular calibration
and spectra acquired with thismethod are automatically calibrated during the acquisition.

Calibrants additionally carry information concerning the applicability of their calibration
coefficients. One part of this information is the mass interval for which this calibrant
delivers useful calibration coefficients. The other part determines whether the particular
calibrant may currently be used to calibrate a LIFT spectrum.

The most prominent feature of the Calibration page is a list either displaying the
calibrants of the currently loaded method, or the fragments of a particular calibrant, which
are expected to be found in the spectrum. Buttons to handle calibrants are found at the
bottom of theCalibration page. After one calibrant is selected and set as the LIFT parent

mass (double-click or ), its name and mass are displayed above the list. On
the right of theCalibration page two groups of controls are shown. The group boxSelect
Parent is activated during the data acquisition and is used to acquire a whole LIFT
spectrum of a particular calibrant, and to start calibrating it. The group boxSelect
Fragment is used to carry out the calibration process of the LIFT spectrum previously
acquired, and is only activated after the data acquisition.

After loading a LIFT method the Calibration page appears in the so- called calibrants
mode (see Figure 3-93). This mode allows the user to edit the calibrant lists, select a
calibrant for calibration, acquire a LIFT spectrum of this calibrant, and begin the calibration
process, which will switch this page into the Fragmentsmode.

Figure 3-93 LIFT Calibration page in calibrants mode, valid method
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In calibrantsmode, the columns of the list reflect the properties of a calibrant.

Calibrants: After a calibrant is set as parent mass, its name andmass are displayed here. 

Valid: A flag (+) indicates that the calibrant is in a well-calibrated state, i.e., no instrument
parameter that influence the LIFT calibration has been changed since the last calibration
process of this calibrant. 

Enabled: A flag (+) indicates that the operator allows using this calibrant.

Name: This is the name of the calibrant.  It does not affect the calibration or the LIFT
measurement process. 

Mass/Da: This is themass of the calibrant (parent ion).

The rows are listed in ascending order according to their mass. 

When there is a calibrant selected and set as the LIFT parent mass, its name and mass
are displayed in the fields above the list.

The four buttons at the bottom of the Calibration page (see Figure 3-93) are used for
handling calibrants:

: Opens the New Calibrant dialog box (see Figure 3-94) to enter the
attributes of a new calibrant, such as name andmass.

Figure 3-94 New Calibrant dialog

: Opens the Edit Calibrant dialog box to edit properties of the selected
calibrant (see Figure 3-95).
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Figure 3-95 Edit Calibrant dialog box

l Name: An arbitrary string can be entered.

l Mass: No range checking is applied to the mass. The user is responsible for a
meaningful value. 

l Calibration Valid: The user can invalidate a valid calibrant by clearing this check
box.  In contrast to this, an invalid calibrant cannot be made valid by selecting its
Calibration Valid check box.  It can only bemade valid by calibrating it. 

Calibration Enabled: Clearing this box temporarily excludes a specific calibrant from a
LIFT experiment. 

l : Deletes the selected calibrant after confirming a warning. Before a
calibrant will be deleted, the user must confirm this action in a dialog box (see
Figure 3-96). 

Figure 3-96 Confirming calibrant deletion
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When the user confirms deleting, the calibrant will be completely removed.  This deletion
can only be undone by re-loading themethod, discarding any changes since the last load. 

l : The state of all calibrants is set to invalid after the user has
confirmed this in a dialog box (see Figure 3-97).

Figure 3-97 Confirming calibrant invalidation

The group boxSelect Parent contains the following features:

l : The mass of the selected calibrant is set as the LIFT parent mass,
i.e., the instrument is prepared to acquire a LIFT spectrum of this substance.  The
same can be achieved by double-clicking an item in the list. This button will only be
active if one of the calibrants in the list is selected.  When a calibrant has been set
as parent, its name andmasswill be displayed above the list.

l : This button is active, if a calibrant is set as parent. In this mode the
parent spectrum is acquired.

l : If this button is active the instrument is prepared to measure the
fragment spectrum and the LIFT fine calibration is triggered. This button can only
be accessed, if a (parent ion) spectrum is present in the sum buffer.

l : Clicking this button initiates the actual calibration process by
switching the Calibration page to Fragments mode. This button is only active, if a
complete LIFT spectrum is present in the sum buffer.
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l : This button can be used after parent and fragment spectra have
been summed and you have switched into the calibrationmode. All fragments from
the LIFT spectrum are assigned at once to the reference masses of the list if they
are within the defined search radius.

l : Defines the range where the automatic assignment of fragments
searches for peaks.

3.7.8.1 Fragments Mode

When the actual calibration process has been initiated, the page will be in Fragments
mode (see Figure 3-98). The user can edit the list of fragments, assign peaks in the
spectrum displayed to fragment reference masses, calculate a new calibration based on
the assigned mass values, and accept or discard the newly calculated calibration, which
will switch the page back to calibrantsmode. 

Figure 3-98 LIFT Calibration page in calibrate mode after fragment assignment

l Fragments of Calibrant: Contains name andmass of the currently used calibrant
to calibrate the instrument. 

l Status: The symbol left hand side indicates the status of the fragment. A dot
means that no actual mass is currently assigned to the particular fragment.  An
arrowhead indicates that an actual mass is currently being assigned to this
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fragment. When a mass assignment exists already for that fragment, the
arrowhead is red otherwise it is green. A check markmeans that an actual mass is
assigned to the fragment.

l Reference Mass: This is the literature value of the fragment mass. 

l Actual Mass: This is the mass of a peak in the spectrum displayed that has been
assigned to the fragment. 

l Mass Error: When a new calibration has been calculated, these columns display
the difference between referencemass and actual mass in ppm andDalton. 

Two buttons below the list serve for housekeeping of fragments.

l : This button opens a dialog box to enter themass of a new fragment.

l : This button deletes the selected fragment, if the user confirms this
action in an appropriate dialog box.

Two fields below the mass list display statistical information regarding the mass error
when a new calibration has been calculated.  These values help to assess the quality of
the calibration. 

The group boxSelect Fragment contains control buttons used for the actual calibration
process.

l : Starts the assign procedure of actual masses to fragments. The
button is pressed until assignment is finished. Assignment can either be finished

explicitly by clicking the button once more, or by clicking

or . When during assignment the end of the list is
reached, the procedure is also finished.

Alternatively masses can be assigned to fragments by double-clicking an item in the
fragment list.

l Zooming : This drop- down list facilitates peak assignment in the Spectrum
window.  The zooming factor refers either to the respective reference mass, or to
absolutemass units. Choosing off displays the wholemass range. 
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l Use PP : When this box is selected, click left of a peak in the display to assign it. 
The peak finder algorithm selected in the processing parameters (see section
3.7.5) is used to calculate the mass.  It will appear as Actual Mass in the list. 
When the check box is cleared, the x-axismass value of the point the user clicked
in the spectrum display will be used directly.

l : Clears all actual mass values and the mass error values.  It can be
used before starting a new assignment process. 

l : A new calibration (i.e., a set of calibration coefficients) will be
performed. 

l : Accepts the last calculated calibration and switches theCalibration
page back to calibrants mode (see Figure 3- 93) .  For storing the updated
calibration permanently, the method has to be saved.  This can be achieved by

clicking the button. 

l : Any calibration activities are discarded and theCalibration page is
switched back to calibrantsmode. 

The button is activated, when a calibration has been calculated and
accepted. This function is the same as that of the command Save Method of the File
menu, or the corresponding feature button on the toolbar.

3.7.8.2 New Fragment

A new fragment can be entered in the New Fragment dialog box (see Figure 3-99). No
range checking is applied to the entered value. The user is responsible for supplying a
meaningful value.

Figure 3-99 New fragment dialog box
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3.7.8.3 Delete Fragment

Before a fragment is deleted, the user must confirm this action in a dialog box.

Figure 3-100 Confirm fragment deletion dialog box

When the user confirms deleting, the fragment is removed. This deletion can only be
undone by re-loading themethod, discarding any changes since the last load.

3.7.8.4 Using Buttons and Boxes to Calibrate the Instrument

The aim of this section is to give an idea of the workflow.  It cannot supply all the expert
knowledge and experience needed to achieve an accurate LIFT calibration over a wide
range of parent masses.

Initial conditions

1. A target with the calibrant substance is introduced into the instrument.

2. The calibrants list containsmasses of the used substance.

3. The instrument parameters of the loaded LIFTmethod are suitable to acquire good
spectra.

At first, a LIFT spectrum has to be acquired:

1. Switch to theCalibration page.

2. If the list contains fragments rather than calibrants, click the button in the
lower right corner.
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3. Choose the first calibrant from the list used for the calibration, and double-click this
calibrant in order to set it as LIFT parent mass.

4. Acquire a LIFT spectrum (parent and fragments) of the selected calibrant. The “better”
the spectrum (low noise, high peak resolution, etc.), the easier is the calibration.

5. If the spectrum is satisfactory, start the calibration procedure with .

6. Click to assign all fragments at once or to assign the first
fragment. The spectrum display will show a red line at the referencemass of the first
fragment.

7. To assign the fragments click in the display left of the respective peak. The assigned
mass will be entered in the list. Use the mouse wheel to switch to the next fragment.
The position of the red line in the spectrum will then be updated to reflect the new
fragment mass. If you want you can use peak picking (Use PP) for the peak
assignment.

8. Repeat this until the end of the list is reached. Assignment will be automatically
finished.

9. Click .  Mass errors will be calculated and displayed in the list.  The
spectrum display will be updated to reflect the modified calibration. Note that at least

nine fragments have to be assigned to get access to the button .

Now it is time for fine-tuning the calibration.  For this important part it is possible to delete
single fragment assignments with a right-mouse-click that seem to be bad, or with the

button , to remove all actual masses from the list.  Select a peak and click

to re-assign a different actual masswith it. After finishing click
to update the calibration and the mass error display.  If the calibration is acceptable, click

and save the updated calibration with .
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3.7.9 LIFT

Figure 3-101 Features of the LIFT page

flexControl provides the LIFT page (see Figure 3-101) in case of a tandem mass
spectrometer and a loaded LIFTmethod (<name>.lft). This page is used to adjust and
modify parameters duringMS/MS experiments. 

Parent Mass: Just as in FAST applications (see section 3.7.10) here the parent mass has
to be defined. Default is the mass, which has been entered at end of the last LIFT
measurement or during the calibration in theCalibration page (see Figure 3-93).

MS/MS List: With this feature it is no longer necessary to type in (or copy and paste) the
exact MS masses manually. The MS/MS list (see Figure 3-102) can be filled with masses
that have been selected in flexAnalysis from a MS spectrum and added there to the
MS/MS list. The complete list can be sent to flexControl (for more details, see the
flexAnalysis User Manual ). Additionally to the mass information the spot information
where the MS spectrum has been acquired is shown, since an MS/MS spectrum can only
be acquired from the spot where it’s MS information comes from. If a mass from this list is
selected the respective spot is automatically chosen (the target moves). After the LIFT
spectrum is acquired and saved the mass is marked with x (see Figure 3-102) in the list.
The list can be deleted by clicking on the cross button.
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Figure 3-102 List with masses selected for MS/MS measurement

PCIS Window Range: The borders of PCIS Window Range insulate the parent mass
from other masses. The values preset inWindow Range depend on the value set inPCIS
Range. In this example the percentage of ± 0.8% means that the window range of the
current precursor mass (1046.54) is ± 8 Da (refer toPCIS Range beneath). 

Acquisition Mode: On selecting the LIFT page the first time the button is
pressed. This button is the same as that in theCalibration page (see Figure 3-93).  The
instrument is prepared tomeasure the parent ion spectrum.

The button is also the same as that in the Calibration page. The instrument
is prepared tomeasure the fragment spectrum and the LIFT fine calibration is triggered.

It is possible tomeasure Fragments Only spectramanually by pressing the
button. Only in the calibration mode it is necessary to acquire and add a parent ion
spectrum to the sum buffer before switching to the fragment mode.

Shots: Enter a number of shots for the fragmentsmeasurement mode.

CID On: Checking this box opens a switching valve for argon to flow into the collision cell
of the ion source.
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CID is an acronym for Collision Induced Dissociation. This term stands for the procedure
where molecules get internal energy by collisions with gas molecules during a passage
through a particular cell. The internal energy leads to so calledmetastable fragmentation,
what is physically a spontaneous dissociation on a microsecond timescale. CID has
proven to be useful to enhance intensities of fragments in the low fragment mass range
and to differentiate between isobaric fragments like i/l peptide fragments.

The button opens the group box Advanced Settings, which contains
features to enable and recalibrate LIFT specific features. The accessibility of this group
box depends on the Bruker Daltonics UserManagement given rights.

Figure 3-103 LIFT page – advanced mode

Parent Assign Mode: This feature is used to assign the parent mass before switching to
the Fragmentsmode. If it is set to Automatic the parent mass is automatically detected, if
it is set to Manual the parent mass has to be selected in the display (click left of the peak,
with Use Peak Picking activated). The following dialog appears and must be confirmed
withOK.

Note This feature applies only to manual LIFT acquisition. During the automatic run
the parent is automatically detected, even ifManual is selected.
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Fragments Mode

l Detector Gain Boost is used to enhance the appearance of fragments by
increasing the detector gain. Defaults are loaded together with the LIFTmethod. 

l Laser Power Boost is also used to enhance the appearance of small fragments
now by increasing the laser power. Defaults are loaded together with the LIFT
method.

l Analog Offset is used to raise the baseline of the digitizer. This may be useful to
suppress the background noise of the electronic components, which are involved in
guiding signals from the detector to the digitizer.  As small fragments may
experience a boost in detector gain and laser power, an offset may be set without
the risk disappearing in the noise.

PCIS Range: The value entered here specifies the size of the window range around the
precursor. The default of 1% should not be changed. But, if this value has been changed
enter the precursor value a second time and press the ENTER key.  flexControl calculates
the new window range.

PCIS : The check box On is used to switch the precursor on or off.  The button

opens the dialogPrecursor Ion Selector Calibration (see Figure 3-104). 
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Figure 3-104 Precursor Ion Selector Calibration dialog

If the ion selector has to be calibrated for a specificmass type it in the fieldCalibration
mass. The pulser timing will be calculated and has to be adjusted. If a well fitting timing is

found press the button . The new calibration can now be

calculated with the button and the constants are displayed in the field Fit
Results. They are applied and transferred to the field Applied Calibration Constants

with the button .

The button in the top left of the dialog (see Figure 3-104) is used to reduce the
size of this dialog.  
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LIFT: There is no direct access to a LIFT calibration if you work with a validated LIFT
method. The calibration can only bemodified after invalidating the current calibration with

the button . It is recommended to do a new calibration only on the copy of an
already calibrated and workingmethod. For acknowledgement press the buttonOK on the
corresponding warningmessage (see Figure 3-105). 

Figure 3-105 Warning before invalidating a LIFT calibration

After that the related button becomes accessible to open the LIFT Pulser
Calibration dialog (Figure 3-106). 
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Figure 3-106 LIFT Pulser Calibration dialog

The usage of this dialog corresponds to that of thePrecursor Ion Selector dialog (Figure
3-104).   

PLMS (Post LIFT Metastable Suppressor):
To (de)activate the PLMS functionmanually use the corresponding check box in the group
box Pulsers (Figure 3-103).  If the check box is selected, PLMS deflects parents formed
after LIFT, together with the metastable fragments created after LIFT. As a result only
desired fragments are visible. If the check box is cleared, the LID fragments, the huge
parent mass and metastable fragments of the parent mass created after LIFT (i.e., Post
LIFTMetastable fragment) are additionally visible.
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As a consequenceMS/MS spectra are recorded in two steps:

1. Check box PLMS = OFF together with low laser power: Basically the parent ion is
detected, together with only very few LID and post LIFT metastable fragments. The
signal recorded in this step is added to the sum buffer. A good resolved and clearly
visible parent signal is desired for the later calibration of theMS/MS spectrum. 

2. Check boxPLMS = ON : With increased (boosted) laser power and increased detector
gain the fragments are recorded and also added to the sum buffer.

These two steps are automatically performed during themanual and automatic acquisition
of LIFT spectra.

Figure 3-107 Post LIFT Metastables Suppressor Calibration dialog
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3.7.10 FAST

Figure 3-108 Features of the FAST page

Laser-desorbed ions may fragment during the flight in the field-free region.  Parent ions
and fragments travel with the same velocity side by side through the TOF and would strike
the linear detector at the same time.  A distinction of parents and fragment ions is not
possible. Fragment spectra can only be obtained with a reflector instrument.

flexControl supports four ways to acquire fragment spectra:

1. Manual FASTmeasurement.

2. Automatic FASTmeasurement (AutoXecute page).

3. LIFT (LIFT page), to record full fragment ion spectra within one single scan.

4. SRM (SRM page), to record a specific fragment with reduced reflector potentials.

The FAST (Fragmentation Analysis and Structural TOF) page (see Figure 3-108) appears
automatically and only when a FAST method (<name>.psm) is loaded. It is used to
configure a FASTmethod for manual and automaticmeasurements.

During FAST measurements the reflector voltage is stepwise reduced to guide fragments
to the reflector detector.  Recorded spectra of the fragments can be finally combined to
one linearized spectrum. 
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Compared with a standard acquisition method following parameters are additionally
defined in a FASTmethod:

l Lowest fragment mass (lowest mass to be expected).

l Ion Selector Window settings (window isolating the parent mass).

Each of the following parameters is related to one segment exclusively:

l Total number of laser shots.

l Reflector detector gain.

l FAST high (upper limit of a FAST segment).

l FAST low (lower limit of a FAST segment).

l CID (Collision Induced Dissociation).

l A FAST voltage list (reflector voltage for any FAST segment).

At the top of the FAST page a path and a sample name have to be selected (see Figure 3-
108). Choose the path with theBrowse-button, the sample name has to be typed in. The
FAST files are stored in a folder like <path>\<Sample Name>\spot

ID\experiment number\<parent mass>.FAST. If a folder of the same name
already exists, the directory will be extended by a counter, e.g. experiment

number\<parent mass>.FAST_2. 

After a path and a sample name are chosen, the parent mass of the FAST measurement
has to be specified. To get only fragments of this ion it has to be isolated by checking the
box Ion Selector . The mass range of the Ion Selector should be small enough to
separate the parent mass from all the adjacent ions, which also deliver fragments.

Figure 3-109 Group Box FAST Status

The FAST status indicator displays the current state of the manual FAST measurement. 
Each rectangle of the indicator represents a FAST segment.  The number of the displayed
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elements is variable and depends on them/z ratio of the chosen parent mass (on the
FAST page) and the value of field Lowest Fragment Mass in the right upper corner of
the FAST Method Editor (see Figure 3-110).  According to this relation the instrument
provides up to 20 FAST segments (maximum). 

To distinguish states of the FAST segments they are displayed in different colors.  FAST
segments, which are not yet processed, are gray. The FAST segment, which is just in
progress, is colored yellow. FAST segments having been processed become green if the
previously chosen total number of spectra is acquired and stored to the sum buffer. 

The user can stop an acquisition at any time. In case of an earlier termination when the
pre-selected maximal number of shots is not yet performed the field representing this
FAST segment becomes light green in color.

Data storage is performed in a manner that the instrument first saves the shot sequences
in the acquisition buffer. The user may add the contents to the sum buffer.

Right of the indicator elements is a group of two fields (view only) showing the number of
the (yellow) FAST segment just being measured and the maximum number of elements
referring to this measurement. The Reflector Voltage field beneath shows the reflector
voltage of this active FAST segment. The view only field Remaining Shots displays a
number of shots still left from the total number of shots previously set in the Number of
Shots for segment field of the FAST Method Editor . Any shot sequence added to the
sum buffer reduces the contents of this display by the number of shots associated with this
sequence.

The three buttons , , below the FAST segment
indicator are used to navigate among the FAST segments for processing. 

When applying the button the first time the FAST folder mentioned above will

be created.  The adjacent element (n+1) becomes activated; turns to the

element processed before (n–1).  The button activates the leftmost FAST
segment. The letter n represents the current FAST segment. 

Reselecting a FAST segment whose spectra are already stored to disk causes a reload of
the data to the sum buffer and displays a spectrum in the related window. 
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Note Reloading a spectrum sets the instrument in a state specified in the FAST
method file! This state might be different to the spectrometer state associated
with the reloaded spectrum! 

When switching between FAST segments, the spectra in the current segment are saved,
the acquisition buffer and sum buffers are cleared, and the parameters specific to the
selected segment are loaded.

When the process of the last FAST segment is finished the button toggles to

and the spectrum is automatically saved.

l Check boxShow apparent masses:

If this box is selected, the RTD shows themass spectrum using theMS reflectron
calibration. These are sometimes called "apparent" masses, because due to the
FAST process, peaks appear at a mass that is different from their actual mass. If
this box is not checked, the same data is displayed using the available FAST
calibration (and therefore showing correct masses). To see masses of the FAST
fragments correctly, leave the box unchecked.

The "apparent" masses are sometimes useful for alignment or diagnosis, for
example, if no valid FAST calibration is available.

Note Due to different calibrations, i.e. conversion from time-of- flight to mass
values, the displayed mass range also differs, although the acquired data
does not change.

l Check boxCID:

Selecting this box opens a valve for guiding collision gas into the collision cell of the
ion source.

l Check box Ion Selector:

This box is used to switch the Ion Selector on or off.
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3.7.10.1 FAST Method Editor

Figure 3-110 Features of the FAST Method Editor

On clicking the button on the FAST page (see Figure 3-108) the FAST
Method Editor window (see Figure 3-110) appears tomodify or draft a FASTmethod. 

The four buttons , , , and in the left
upper corner are used to select rows of the currently loadedmethod to examine or modify
parameters. 

Each time on changing a FAST segment, parameters of the previous FAST segment are
copied into the list of FAST segment specific parameters. The parameters of the newly
activated FAST segment are displayed in the corresponding entry fields. The button

is related to the current FAST segment. 
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The group box segment x of y requires FAST segment specific parameter inputs (The
numbers x and y are variables and vary depending on the m/z ratio of parent and fragment
masses as explained above).

The fields FAST Low and FAST High are used to specify the range of a FAST segment
where the boundaries should overlap the adjacent segments. For the autoflex defaults are
80% of the parent mass for FAST Low and 102% of the parent mass for FAST High. 
Later on the segments can be joined together to a linearized spectrum. TheRef. Detector
Gain depends on the S/N ratio. 

The value in the field Number of Shots for Evaluation corresponds to the number of
shot per sequence and is updated simultaneously in the field Shots of the Target
Manipulation segment. 

The value in the field Number of Shots for segment corresponds to the total number of
shots, which are finally the contents of the sum buffer for this specific segment.

flexControl is an universal control software for all the different mass spectrometers of the
flex series. Taking into account the different instrument specific hardware, flexControl
allows adjusting the total available laser power in proportional steps that is requested for
the first segment of a specific instrument.

The function of the check boxRealtime Smooth corresponds to that one in the
Detection page (see section 3.7.3) .  However, in this case it refers to one specific
element. 

The parameter Lens Voltage is the same as that in the Spectrometer page.  If the CID
function is selected on the FAST/LIFT page the edit field in the dialog becomes activated
to set a value different to that previously set onSpectrometer page. 

The list contains all the editable parameters of the group box segment above and the
previously selected voltage list. Any row corresponds to a voltage segment; the columns
contain the segment specific adjustments. To experiment with parameters select a row
that corresponds to the voltage segment you want to manipulate and edit the fields in the
group box segment.  Any parameter change for a voltage segment takes effect with the

button .  For example, when Realtime Smooth is selected the
corresponding position in the columnRTS is set toON.

The group box All segments contains parameters with a global character, which are
therefore valid for the entire FAST spectrum. The first line is used to specify the Lowest
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Fragment Mass, whose relation to the parent mass corresponds to the displayed number
of FAST segments (see Figure 3-109). 

On clicking the button the values are buffered and the dialog will be closed. 
The values are not stored in the FASTmethod file automatically.

3.7.10.2 Performing a Manual FAST Acquisition

1. Select a suitable FAST method ( *.psm ), if not yet loaded with the button

on the System Status segment of the GUI.  The page FAST
immediately appears in the SystemConfiguration segment.

2. Start the acquisition by applying the button on theAcquisition
Control segment of the GUI (Figure 3-42).

3. Add the acquired spectrum to the sum buffer by applying the button.

4. Repeat this action until the number of remaining shots in the corresponding field on the

lower right of the FAST page has become zero.  The button becomes
green in color.

5. Apply the button .  The color of the first segment on the page FAST
changes from yellow to dark green; the second segment becomes active and yellow in
color. 

6. Repeat steps 2 to 5 until all segments are processed.  If the operator is satisfied with a
smaller number of added spectra as defined in the method he may press the button

between two scans.  The current voltage segment becomes light green
and the color of following segment turns to yellow: it is now active.

7. When all segments have been processed, they all are colored dark or light green. The

color of the button changes from gray to dark green.  

The button at the left lower corner of the FAST page becomes active after
the first segment is completely processed. It may be used to terminate the FAST
measurement in between. Before the measurement is terminated, a confirmation
message appears (see Figure 3-111). 
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Figure 3-111 Click Yes to terminate

A stop reloads instrument settings referring to the first FAST segment of the run. 

3.7.11 SRM

Figure 3-112 Features of the SRM page

The SRM (Single Reaction Monitoring) page (see Figure 3-112) appears automatically
and only when an SRM method (<name>.srm) is loaded. It is used to configure a SRM
method for manual and automaticmeasurements.

During SRM measurements the reflector voltage is reduced to guide fragments to the
reflector detector.   

Compared with a standard acquisition method following parameters are additionally
defined in a SRMmethod:
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l Fragment mass.

l Ion Selector Window settings (window isolating the parent mass).

Each of the following parameters is related to the fragment exclusively:

l Total number of laser shots.

l Reflector detector gain.

l FAST high (upper limit of a FAST segment).

l FAST low (lower limit of a FAST segment).

l CID (Collision Induced Dissociation).

l FAST voltage list (reflector voltage for any FAST segment).

l Define Parent Mass, Fragment Mass and the correspondingMass Ranges.

To get only the fragment of this ion it has to be isolated by checking the box Ion
Selector . The mass range of the Ion Selector should be small enough to
separate the parent mass from all the adjacent ions, which also deliver fragments.

l Check boxShow apparent masses (see Figure 3-112):

If this box is selected, the RTD shows the mass range and accompanying peaks
that are associated with the segment currently in use. Otherwise the entire mass
range is displayed. 

l Check boxCID:

Selecting this box opens a valve for guiding collision gas into the collision cell of the
ion source.

l Check box Ion Selector:

This box is used to switch the Ion Selector on or off.

l Window Range fields: The window range for the Ion Selector can be defined
with these fields. The borders of PCIS Window Range insulate the parent mass
from other masses.
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3.7.11.1 Method Editor

Figure 3-113 Features of the Method Editor

Clicking the button on the SRM page (see Figure 3-112) opens the
Method Editor (see Figure 3-113) for modifying or drafting an SRMmethod. 

The four buttons , , , and in the left
upper corner are used to select rows of the currently loadedmethod to examine or modify
parameters. 

Each time on changing a FAST segment, parameters of the previous FAST segment are
copied into the list of FAST segment specific parameters. The parameters of the newly
activated FAST segment are displayed in the corresponding entry fields. The button

is related to the current FAST segment. 
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The group box segment x of y requires FAST segment specific parameter inputs (The
numbers x and y are variables and vary depending on them/z ratio of parent and fragment
masses).

The fields FAST Low and FAST High are used to specify the range of a FAST segment
where the boundaries should overlap the adjacent segments. For the autoflex defaults are
80% of the parent mass for FAST Low and 102% of the parent mass for FAST High. 
Later on the segments can be joined together to a linearized spectrum. TheRef. Detector
Gain depends on the S/N ratio. 

The value in the field Number of Shots for Evaluation corresponds to the number of
shot per sequence and is updated simultaneously in the field Shots of the Target
Manipulation segment. 

The value edited in the field Number of Shots for segment corresponds to the total
number of shots, which are finally the contents of the sum buffer for this specific segment.

flexControl is an universal control software for all the different mass spectrometers of the
flex series. Taking into account the different instrument specific hardware, flexControl
allows adjusting the total available laser power in proportional steps that is requested for
the first segment of a specific instrument. The function of the check boxRealtime Smooth
corresponds to that one in theDetection page (see section 3.7.3). However, in this case
it refers to one specific element. 

The parameter Lens Voltage is the same as that in the Spectrometer page.  If the CID
function is selected on the FAST/LIFT page the edit field in the dialog becomes activated
to set a value different to that previously set onSpectrometer page. 

The list contains all the editable parameters of the group box segment above and the
previously selected voltage list. Any row corresponds to a voltage segment; the columns
contain the segment specific adjustments. To experiment with parameters select a row
that corresponds to the voltage segment you want to manipulate and edit the fields in the
group box segment.  Any parameter change for a voltage segment takes effect with the

button .  For example, when Realtime Smooth is selected the
corresponding position in the columnRTS is set toON.

The group box All segments contains parameters with a global character, which are
therefore valid for the entire FAST spectrum. The first line is used to specify the Lowest
Fragment Mass, whose relation to the parent mass corresponds to the displayed number
of FAST segments (see Figure 3-109). 
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On clicking the button the values are buffered and the dialog will be closed. 
The values are not stored in the FASTmethod file automatically.

3.7.11.2 Performing a Manual SRM Acquisition

1. Select a suitable SRM method ( *.srm ), if not yet loaded with the button

on the System Status segment of the GUI.  The page SRM
immediately appears in the SystemConfiguration segment.

2. Enter the parent mass of the ion to be analyzed in theParent Mass field.

Optional: Check the parent ion by acquiring a parent spectrum using the

button on the Acquisition Control segment of the GUI
(see Figure 3-42).

3. Click the button on theSRM page.

4. Enter the fragment mass to be analyzed in the Fragment Mass field.

5. Start again the acquisition by clicking the button on theAcquisition
Control segment of the GUI (see Figure 3-42).

6. Save the spectrumwith the or the button.
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3.7.12 Setup

Figure 3-114 Features of the Setup page

The Setup page (see Figure 3-114) is used to adjust peripheral equipment, such as
detector, laser attenuator and digitizer, etc. Depending on the Bruker Daltonics
UserManagement given rights this page is available or unavailable. When available, all
controls are read-only on this page. To enable modifications, the service access is
required (see section 3.4.6.2).

3.7.12.1 Overview Setup Page

Laser Settings

The offset and range fields define the operating range of the laser attenuator and focus.
Normally the values entered in Offset andRange fix the bounds of a sub range within the
range of the total available laser settings. If the system is equipped with a smartbeam
laser, multiple parameter sets are available which can have different settings for the
attenuator and focus offset and range. The Parameter Set drop-down list is used to
switch between the settings for the individual sets. Since the Setup page is normally
deactivated the recommended way to select a different parameter set for a flexControl
method is to switch to theDetection tab and perform the change there.

The attenuator offset used is generated by adding the contents ofGlobal Attenuator
Offset field and theAttenuator Offset field. The attenuator offset and range are used to
define the operating range of the laser slider on the Acquisition Control segment (see
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Figure 3-42). This restriction allows a finer adjustment of laser power in this portion. In this
example the value entered in Offset is the lower bound and initial value within this
confined operating range of the slider, which corresponds to 68% of the total available
laser power. The entered value in Range (20%) corresponds to the upper bound of the
slider’s operating range, which is 88% of the total available laser power. Within this
confined range the (relative) laser power can be varied from 0% to 100%.

Laser Focus settings

Depending on the laser type this function is active or not. The values forOffset andRange
define also an operating range and Value focuses a lens into the optimal position within
this predefined range.

Digitizer Settings

The digitizer is equipped with up to two input channels. One is coupled to the linear
detector the second is used for the reflector detector.

The sensitivity for the digitizer inputs is fixed to the value displayed in the Sensitivity field.
TheAnalog Offset fields are used to adjust the baseline of the acquired spectra.

Detector Gain Voltage Offset Settings

The two reflector voltages correspond to a bias where the amplification factor of each
detector is assumed. These values may be adjusted to the experiment. Additionally the
voltage for the reflector detector may be changed with the corresponding slider in the
Detection page (see section 3.7.3).

The Save button saves the current settings. The software always uses the
same file to ensure that all (Windows) users operate with the same instrument settings.
Backup copies of the previous setting are automatically created whenever the new
settings are saved.

The Import button can be used to import the settings from a backup copy or
from a different file.

TheExport button can be used to save the settings to a different file.
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3.7.13 Status

Figure 3-115 Features of the Status page

TheStatus pagemonitors themass spectrometer and the attached peripheral equipment,
such as the processor subsystem, high voltage, sample carrier, etc.  Applying the

button opens an additional set of pages reflecting detailed instrument states.

Here you can find e.g. the source cleaning maintenance interval bar, which gives you
information about when the source of your instrument has to be cleaned.

Page 144 of 166 flexControl 3.4 User Manual Revision 1



Bruker Daltonik GmbH 3 Graphical User Interface (GUI)

Figure 3-116 Status Details with Source Cleaning Maintenance Interval bar

Figure 3-117 Source Cleaning at the ultrafleXtreme

As soon as 80% are reached, you will get a message, which either asks you to clean the
source or offers you to start the cleaning procedure. Depending on the connected
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instrument, the cleaning of the source must be fulfilled in different ways:
For autoflex and ultraflex I-III it is done by using the Source Shower target, a message
pops up to remind you that cleaning will be necessary (see Figure 3-118).

Figure 3-118 Source Cleaning Maintenance Interval >80% (e.g. autoflex)

For further information on using the Source Shower target, please refer to the Source
Shower Target Manual.

For the ultrafleXtreme and the Autoflex Speed an automatic cleaning procedure is
implemented. This procedure can either be started by confirming the cleaning source
message or manually by pressing the button (see Figure 3-117) . The
procedure takes approximately 20minutes.

On the right side of the status page, there are the two buttons and

to change the status of the mass spectrometer from the operationmode into
the stand bymode and vice versa.

Applying the button right hand, the high voltage, the camera, the lamp, the
laser, and the digitizer are switched off. Additionally followingmessage appears:
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Figure 3-119 Message asking how to continue

The button opens theStatus Reporter (see section 3.4.6.3).

The button opens theDetector Check (see section 3.7.14).

3.7.14 Detector Check

DetectorCheck is a software tool used to measure detector gain curves in linear and
reflectronmode. The tool also calculates detector voltage values required to obtain certain
single ion response values.

Using this tool enables long-term monitoring of detector performance and assists users in
compensating for detector aging. This is achieved by readjusting the detector voltage to
obtain a constant detector gain in their projects over time.

ClickingStart triggers a fully automated five-minute test sequence consisting of:

l loading all instrument settings andmethods needed for the test

l optimization of the detector offset and the laser power

l measuring the detector gain in linear and reflectronmode

l restoring the original instrument settings / methods.

It is recommended that the test is run on amonthly schedule and before important
projects.
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3.7.14.1 DetectorCheck Workflow

3.7.14.1.1 Performing the Test Sequence

1. Insert a MALDI target with prepared HCCAmatrix spots into your instrument.

Use of Bruker Prespotted AnchorChip targets (Part No. # 227463 or # 231968) is
recommended for Ultraflex/Autoflex instruments. These targets offer the highest
preparation reproducibility and convenience of use because they are precoated with
HCCAmatrix and therefore no sample preparation is needed to perform this test.

Note For microflex instruments we recommend to prepare HCCAmatrix (Bruker
part No. # 201344) saturated in ACN:0.1%TFA (1:2) onto a stainless steel
target. A consistent result history can only be achieved when the same
matrix preparation is used for all subsequent tests.

2. Teach the sample carrier spot positions and select a freshmatrix spot for the test.

The teaching procedure is described in flexControl Help (see section 3.4.6) . The
teaching is considered successful when a selected fresh spot is centered in the cross
hairs of the flexControl video window.

3. Start the DetectorCheck test procedure:

On the flexControl Setup tab selectDetector Check and press theStart Check
button.

The whole test procedure runs fully automatically. During the measurement (indicated by
the progress bar) the detector gain in linear and reflectron mode is measured. You can
stop the test at any time by clicking on theCancel button. After approximately fiveminutes
the test is complete and the instrument reloads all previousmethods / settings.

It is recommended that the test is run on amonthly schedule and before important
projects.

3.7.14.1.2 Displaying the Results

Immediately after the measurement has finished the result is shown on the Detector
Checkwindow. The upper graph shows the detector gain in linear and reflector mode, i.e.
the response to single ion impact plotted against detector voltage. Due to the nature of the
electron amplification process in the detector, the graph in this plot should be straight lines.
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Figure 3-120 Results of the detector check procedure
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The result history of all tests run on your instrument is shown in the lower graph. The two
curves represent the recommended detector voltages to obtain good spectra for small
molecules/peptides in reflectron mode and for proteins in linear mode. Detector aging is
indicated by a rising curve:When the detector performance decreases, a higher voltage is
required for the same response.

The actual recommended voltage values are given below the graph

The result history is also archived in the result table (pressShow Result Table).

Figure 3-121 Detector check result file
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3.7.14.1.3 Achieving Long-Term Detector Response Stability

The main benefit of the Detector Check tool is providing a track record of detector
response, enabling users to maintain a stable response even if the detector performance
degradesmarginally over time.

This long- term stability can easily be achieved by periodically readjusting the detector
voltage in your flexControl methods according to Detector Check tool results:

1. Load the flexControl method to be readjusted.

2. Click theDetection tab and take note of the actual detector voltage shown on the right
side of the detector gain slider.

3. If the actual detector voltage and the recommended detector voltage (as determined
by the DetectorCheck tool) differ bymore than 30 V, move the Detector Gain slider to
the recommended value.

Note If the flexControl method is a linear (reflector) method apply the respective
linear (reflector) value of the recommended detector voltage.

4. Save the flexControl method.

Figure 3-122 Adjusting the Detector Gain
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Appendix A — Appendix

A.1 WARP feedback strategy with BioTools

The following workflow gives a short overview of the AutoXecute WARP feedback
strategy that is used in combination with BioTools.

1. Select theWARP strategy BioTools in theAutoXecute settings dialog (see Figure 3-
71) on theAutoXecute tab in flexControl and restart flexControl.

Figure A-1 Feedback from BioTools option

2. Setup an AutoXecute run with MS andMS/MSmeasurement.

3. Make sure that the MS spectra will be sent to BioTools after post processing in
flexAnalysis, i.e. select a BioToolsmethod in the AutoXecuteMSmethod (Processing
page (see Figure 3-60) or the AutoXecute run (see section 3.7.1.4)).

4. Make sure thatWARP is selected in theMS/MS tab of the AutoXecuteMS/MSmethod
(see Figure 3-61). Otherwise the information BioTools adds to the peak list will be
ignored!

5. Make sure that the BioTools Feedback Parameters are selected correctly in the used
BioToolsMSmethod:
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Figure A-2 MS/MS acquisition parameters in BioTools 3.2

A.2 ISD

For a description of the ISD workflow please consult the respective Biotools tutorial.

A.3 T3-Sequencing

For a description of the T3-sequencing workflow please consult the respective Biotools
tutorial.
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A.4 Fuzzy Logic Control Module

What is Fuzzy Logic?

Fuzzy logic tries to resemble human reasoning.  Inexact descriptions like “Somebody is
small” or “The temperature is high” often lead to questions like “How many centimeters are
small?” and “How many centigrade are high?”. For example, the fuzzy or multivalued logic
approach allows any value on the temperature axis to represent the quality high to a
certain degree. The degree is defined by a weight or truth function, which often falls down
on both sides of a maximum and becomes zero outside a certain interval.  Other
temperature qualities, such as low or medium with overlapping truth functions may be
added to build a fuzzy temperature description (see Figure A-3).   

Figure A-3 Overlapping temperature curves

The fuzzy temperature representation between 10°C and 30°C uses five slightly
overlapping areas (fuzzy sets) describing five temperature qualities.

The main idea of fuzzy control lies in the usage of these overlapping sets covering the
definition interval of each input and output parameter.  A certain input value belongs to
different input sets to a certain degree (fuzzification).  Simple logical rules connect the
input sets to appropriate output sets.  For example, when the input value is a member of
the set I1 to a certain degree than the output value belongs to the set O1 to this degree. 

Finally a non-fuzzy output is retrieved from the output sets (defuzzyfication).
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A simple example:

Suppose the goal is to build up a ventilator control subsystem for an air condition. The only
input is the current room temperature.  The only output is the relative speed of the
ventilator system providing the room with fresh air.  To simplify this example the heating of
this roommay be controlled by a different system.  In order to achieve this goal with a fuzzy
logic control system the input and output parameter space must be available in a fuzzy
representation.  For the temperature we can use the fuzzy representation of Figure A-3. 
For the relative ventilator speed a straightforward approachmay also consist of five fuzzy
sets covering the speed parameter space (Figure A-4). 

Figure A-4 Relative ventilator speed

The fuzzy representation of the relative ventilator speed uses also five overlapping areas
(fuzzy sets) for five different speed qualities.  Now the fuzzy sets describing the
temperature and the fuzzy sets describing the ventilator speed must be connected. This is
done by several logical rules.  If the input and output sets are given meaningful names the
logical rules will describe the control system in a semanticmeaningful way. 

In our case we have the following five rules (In general the rules are more complicated
employingmore complex logical constructs.):

Rule 1: If temperature is cold then speed is stop.

Rule 2: If temperature is cool then speed is slow.

Rule 3: If temperature is just right then speed ismedium.

Rule 4: If temperature is warm then speed is fast.

Rule 5: If temperature is hot then speed is very fast.
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One evaluation cycle starting with a temperature of 21°C and resulting in a relative
ventilator speed of 60.1 is discussed below (Figure A-5). 

l Fuzzyfication step: An input temperature of 21°C is presented to the system and is
classified as belonging mainly to the temperature quality (fuzzy set) just right but
also to aminor degree to warm.

l Implication step: According to the five rules stated above the medium quality is
mainly activated (rule3) from the ventilator speed representation but also to a less
degree the fast quality (rule4).  The fuzzy output sets are scaled according to their
activation. 

l Aggregation step: All activated areas of the fuzzy ventilator representation are
combined into a single fuzzy set in preparation of the final step. 

l Defuzzification step: In order to gain just one number describing the new ventilator
speed an average valuemust be somehow extracted from the fuzzy output.  In our
case a centroiding approach is used to achieve this. The result is 60.1.
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Figure A-5 One evaluation cycle

One evaluation cycle for the fuzzy control logic based ventilator control system.  The input
value of 21°C is fuzzyfied.  According to the specified implication rules some fuzzy output
sets are activated to a certain amount.  After having aggregated the activated output sets
to one fuzzy output an averaging step extracts on specific output value (60.1).

To get an overall impression of the behavior of the controlling system an evaluationmay be
done for every input value, thus creating a temperature to speed mapping (see Figure A-
6).  The result is a continuous piecewise linear function.  It exhibits a very temperature
sensitive behavior in the center part (small temperature changes lead to a large ventilator
speed changes), surrounded on both sides by insensitive areas (flat curve parts), which
prevent an overshooting of the controlling system. The flat curve parts at both ends of the
temperature interval are due to the border effect and can be avoided by a more careful
modeling.  In order to get a smooth temperature to speed mapping the input fuzzification
may be done using Gaussian bell functions instead of triangles.

Figure A-6 Temperature to speed mapping
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Figure A-6 shows the temperature to speed mapping resulting from the fuzzy logic based
ventilator control system.  The steep curve part in the center is responsible for a fast
reaction on temperature changes around the optimal temperature value. 

The following flat curve parts provide insensitivity to small temperature changes there. 
The steep curve parts at the interval borders create a fast change of ventilator speed in
order to leave these areas as soon as possible. 

This example shows that even our simple approach to create a fuzzy representation of the
input and output space together with five straightforward rules connecting input side to
output side led to a well suited controlling system. 

The Fuzzy Control of AutoXecute

The fuzzy control module in AutoXecute has two input and two output parameters (see
Figure A-7).  It judges any acquired spectrum and decides whether the laser power may
be changed in order to increase the spectrum quality and if the spectrum is good enough to
be added to the sum buffer, which will finally saved to disk.  The fuzzy control module in
AutoXecute takes intensity and resolution of the acquired spectrum to adapt the laser
power and to decide whether data are good enough to be saved.

Figure A-7 Scheme of the fuzzy control module

In order to cope with different substance groups and different instrument settings the fuzzy
control modulemay be initialized with different fuzzy control files thus implementing special
fuzzy engines, which define the acceptable intensity and resolution values for different
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measure processes.  Currently are five fuzzy engines available (several more are
presently tested and will be released soon).

Finally a 3D-plot (see Figure A-8) showing the rather non-linear connection between the
two input parameters (intensity and resolution) and more input parameters (add spectrum
to sum) may complete this section. 

Figure A-8 Dependency of the Add function from resolution and intensity

Only when the value of the adding output is big enough the sum is added to the sum buffer
(higher area of the surface). Smaller values lead to a rejection of the spectrum (lower area
of the surface). 
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Table A-1 List of Fuzzy Engines

Fuzzy Engine Description

peptides The standard fuzzy engine for peptide measurements.
(This fuzzy engine is identical to tof_default) 

oligo_resx6 The standard fuzzy engine for oligo measurements.  As difference to
the peptides fuzzy engine oligo_resx6 accepts very small per shot
peak intensity. To avoid the summing of noise peaks, peak resolution
6 times the specified resolution threshold leads to a rejection of the
spectrum (resolution too high).

oligo_resx10 This fuzzy engine behaves exactly as oligo_resx6 except that too a
high resolution is considered 10 times the specified resolution
threshold. 

oligo resx3 This fuzzy engine behaves exactly as oligo_resx6 except that too a
high resolution is considered 3 times the specified resolution
threshold. 

oligo resx2 This fuzzy engine behaves exactly as oligo_resx6 except that too a
high resolution is considered 2 times the specified resolution
threshold. 

fast_high_int This is the fuzzy engine for automated FAST/PSD measurements on
sample spots with relative high substance concentration.

fast_med_int This is the fuzzy engine for automated FAST/PSD measurements on
sample spots with medium substance concentration.

fast_low_int This is the fuzzy engine for automated FAST/PSD measurements on
sample spots with low substance concentration.
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